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IMPORTANT NOTICE 

All statements, technical information, and recommendations in this document which relate to the products supplied 
by Meggitt SA are based on information believed to be reliable, but unless otherwise expressly agreed in writing 

with Meggitt SA the accuracy or completeness of such data is not guaranteed. Before using this product, you must 
evaluate it and determine if it is suitable for your intended application. You should also check our website at 

www.meggittsensing.com/energy for any updates to data sheets, Ex certificates, product drawings, user manuals, 
service bulletins and/or other instructions affecting the product. 

Unless otherwise expressly agreed in writing with Meggitt SA, you assume all risks and liability associated with use 
of the product. Meggitt SA takes no responsibility for any statements related to the product which are not contained 

in a current English language Meggitt SA publication, nor for any statements contained in extracts, summaries, 
translations or any other documents not authored and produced by Meggitt SA. 

The certifications and warranties applicable to the products supplied by Meggitt SA are valid only for new products 
purchased directly from Meggitt SA or from an authorised distributor of Meggitt SA. 

Meggitt SA reserves the right to alter any part of this publication without prior notice. 

 

 
EXPORT CONTROL 

The information contained in this document may be subject to export control regulations of the European 
Community, USA or other countries. Each recipient of this document is responsible for ensuring that the transfer or 
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PREFACE 
 

About these release notes 

This document provides important information about the VibroSight® software from Meggitt SA. It is applicable to all 
VibroSight-based condition monitoring systems using the versions of software described by this document, namely: 

• VibroSight software version 7.0.0 (part number (PNR) 609-004-000-052). 

This document contains information about changes to the software since the previously released version 
(VibroSight 6.1.x), such as new features and improvements, solved problems and bug fixes, and hardware and 
software compatibility. 

For more general information on the actual software, or the entire machinery protection system (MPS) and/or 
condition monitoring system (CMS), refer to the following Meggitt SA documentation: 

 VibroSight® software data sheet 
        (document reference 660-020-005-223A) 

 Getting started with VibroSight® installation guide 
        (document reference 660-010-006-230A) 

 VibroSight® help 

 VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module data sheet 
        (document reference 268-121) 

 VM600Mk2 RLC16Mk2 relay module data sheet 
        (document reference 268-125) 

 VM600Mk2 CPUMMk2 + IOCNMk2 rack controller and communications interface module data sheet 
        (document reference 268-135) 

 VM600Mk2/VM600 XMx16 + XIO16T extended condition monitoring modules data sheet 
        (document reference 660-020-010-210A) 

 VibroSight application notes and technical notes. 

 

Users who are familiar with VibroSight may also find it useful to refer to the release notes included in earlier 
versions of the software: 

• VibroSight 6.1.0 (document reference 660-010-013-232A) 

• VibroSight 6.0.0 (document reference 660-010-013-231A) 

• VibroSight 5.1.0 (document reference 660-010-013-230A) 

• VibroSight 5.0.0 (document reference 660-010-013-229A) 

• VibroSight 4.1.0 (document reference 660-010-013-228A) 
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• VibroSight 4.0.0 (document reference 660-010-013-227A) 

• VibroSight 3.8.0 (document reference 660-010-013-226A) 

• VibroSight 3.7.0 (document reference 660-010-013-225A) 

• VibroSight 3.6.0 (document reference 660-010-013-224A) 

• VibroSight 3.5.0 (document reference 660-010-013-223A) 

• VibroSight 3.4.0 (document reference 660-010-013-222A) 

• VibroSight 3.3.0 (document reference 660-010-013-221A) 

• VibroSight 3.2.0 (document reference 660-010-013-220A) 

• VibroSight 3.1.0 (document reference 660-010-013-219A) 

• VibroSight 3.0.0 (document reference 660-010-013-218A) 

• VibroSight 2.12.7 (document reference 660-010-013-217A) 

• VibroSight 2.12.6 (document reference 660-010-013-216A) 

• VibroSight 2.12.5 (document reference 660-010-013-215A) 

• VibroSight 2.12.4 (document reference 660-010-013-214A) 

• VibroSight 2.12.3 (document reference 660-010-013-213A) 

• VibroSight 2.12.2 (document reference 660-010-013-212A) 

• VibroSight 2.12.1 (document reference 660-010-013-211A) 

• VibroSight 2.12.0 (document reference 660-010-013-210A) 

• VibroSight 2.11.6 (document reference 660-010-013-209A) 

• VibroSight 2.11.5 (document reference 660-010-013-208A) 

• VibroSight 2.11.4 (document reference 660-010-013-207A) 

• VibroSight 2.11.3 (document reference 660-010-013-206A) 

• VibroSight 2.11.2 (document reference 660-010-013-205A) 

• VibroSight 2.11.1 (document reference 660-010-013-204A) 

• VibroSight 2.11.0 (document reference 660-010-013-203A) 

• VibroSight 2.10.1 (document reference 660-010-013-201A) 

• VibroSight 2.10.0 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.7 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.6 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.5 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.4 (document reference VIBROSIGHT-RN/E) 
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• VibroSight 2.9.2 (document reference VIBROSIGHT-RN/E) 

• VibroSight 2.9.1 (document reference VIBROSIGHT-RN/E). 

 

Use of the release notes 

You should read those sections that are most relevant to you and then keep the document for future reference. 

 

Version identifiers 

A complete VibroSight software version number has four components that provide the following information: 

• x.x.x.x, major release identifier – typically incremented once per year. 

• x.x.x.x, minor release identifier – incremented for each release with typically four scheduled releases per year. 

• x.x.x.x, “hotfix” release identifier – 0 for a normally scheduled release and incremented for each hotfix release. 

• x.x.x.x, software build number – for internal use. 

For each scheduled release of VibroSight, at least one of the first two digits changes (x.x.x.x). 
For unscheduled “hotfix” releases, which are occasionally required to solve urgent problems, the third digit changes 
(x.x.x.x). 

The version identifiers for installed software appear in the Help About box (obtained using Help > About … in any 
VibroSight software module). 
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Terminology 

To distinguish between the different Meggitt SA products that can be used with the VibroSight® software, the 
following terminology is used in this document: 

 

• VM600Mk2/VM600 modules/card(s) – to refer to VibroSight compatible cards that are installed in a 
VM600Mk2/VM600 rack (that is, the first generation of VM600 systems). 

The currently available VM600Mk2/VM600 modules/cards that are designed for operation with the VibroSight 
software are the XMx16 card pairs (XMC16 / XIO16T, XMV16 / XIO16T and XMVS16 / XIO16T) and the 
CPUx card pairs (CPUR2/IOCR2 and CPUR/IOCR). 

Note: It is important to note that VibroSight Configurator is still used for the configuration of these 
VM600Mk2/VM600 modules/cards/systems. 

Where XMx16 is used in this document, it refers to XMC16 / XIO16T, XMV16 / XIO16T and XMVS16 / XIO16T 
cards, unless otherwise stated. 

Where CPUx is used in this document, it refers to CPUR2/IOCR2 and CPUR/IOCR cards, unless otherwise 
stated. 

 

• VM600Mk2 module(s) – to refer to VibroSight compatible modules that are installed in a VM600Mk2 rack (that is, 
the second generation of VM600 systems). 

The currently available VM600Mk2 modules that are designed for operation with the VibroSight software are the 
MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module, the RLC16Mk2 relay module and the 
CPUMMk2 + IOCNMk2 rack controller and communications interface module. 

Note: It is important to note that VibroSight Protect is used for the configuration of VM600Mk2 modules/systems. 

 

• VibroSmart® module(s) or VibroSmart® device(s) – to refer to VibroSight compatible VibroSmart modules or 
devices that are used in a VibroSmart distributed monitoring system. The currently available VibroSmart 
modules and devices that are designed for operation with the VibroSight software are the VSI010, VSN010 and 
VSV30x. 

Where VibroSmart module is used in this document, it refers to the VSI010 and VSV30x modules, unless 
otherwise stated. 

Where VibroSmart device is used in this document, it can refer to the VSN010 device only, or to the VSI010 
and VSV30x modules and the VSN010 device, unless otherwise stated. 

Where VSV30x is used in this document, it refers to VSV301 and VSV300 modules, unless otherwise stated. 
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1 Licensing 

Since VibroSight 4.0.0, the ability to install and run VibroSight software updates and upgrades depends on the 
purchased “Updates and support” package. 

NOTE: VibroSight 7.0.0 is a major level release and a new license key file is not required 
for updates and upgrades from VibroSight 6.x.x. 

However, a new license key file is required for updates and upgrades from 
VibroSight 3.8.x or earlier. 

 

For further information on licensing or to obtain a new VibroSight license key file, contact Meggitt SA customer 
support. See 7 Customer support. 

 

2 Features 

General 

2.1 Support for VM600Mk2 – the next generation of VM600 machinery protection and 
condition monitoring system 

VibroSight 7.0.0 introduces full support for the second generation of VM600 rack-based machinery protection and 
condition monitoring systems – known as VM600Mk2 – for condition monitoring applications. 

More specifically, with VibroSight 7.0.0 and new condition monitoring firmware for the MPC4Mk2 + IOC4Mk2 
machinery protection and condition monitoring module, VibroSight / VM600Mk2 systems can now be used for 
condition monitoring applications, in addition to the existing support for machinery protection applications (which 
has been available since VibroSight 6.0.0). 

 

VM600Mk2 hardware 

The Meggitt vibro-meter® VM600Mk2 rack-based monitoring system is the evolution of the original VM600 
(VM600Mk1) solution for the protection and monitoring of rotating machinery used in the power generation and oil & 
gas industries. VM600Mk2 solutions are recommended when a centralised monitoring system with a medium to 
large number of measurement points (channels) is required. VM600Mk2 is typically used for the monitoring and/or 
protection of larger machinery such as gas, steam and hydro turbines, and generators, smaller machines such as 
compressors, fans, motors, pumps and propellers, as well as balance-of- plant (BOP) equipment. 

VM600Mk2 systems use existing VM600Mk2/VM600 rack infrastructure (racks and power supplies) with a new set of 
VM600Mk2 modules: 

• VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module 

• VM600Mk2 RLC16Mk2 relay module 

• VM600Mk2 CPUMMk2 + IOCNMk2 rack controller and communications interface module. 
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These VM600Mk2 modules use the latest technology to offer improved performance compared to the existing first-
generation VM600 (VM600Mk1) MPC4 / IOC4T machinery protection card pair, RLC16 card, and CPUx / IOCx rack 
controller and communications interface card pairs. 

NOTE: The VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring 
module is a significant development in machinery monitoring because in addition to 
matching or bettering the outstanding specifications and performance of the 
MPC4 / IOC4T, the MPC4Mk2 + IOC4Mk2 now also supports condition monitoring – 
that is, machinery protection and condition monitoring are now available from a 
single module. 

 

VM600Mk2 software 

The VibroSight software includes significant updates to all of its software modules (VibroSight Server and 
VibroSight client application modules (System Manager, Vision, etc.)) in order to support the new VM600Mk2 system 
and modules. 

Significantly, VibroSight 7.0.0 now includes VibroSight Capture, a new VibroSight client application dedicated to the 
configuration and operation of VM600Mk2 systems (specifically MPC4Mk2 + IOC4Mk2 modules) for condition 
monitoring applications. 

As a result, VibroSight now has three separate software modules that are used for the configuration of different 
VM600Mk2/VM600 system configuration: 

• VibroSight Protect supports the configuration and operation of the machinery protection (MPS) functionality for 
a VM600Mk2 system (MPC4Mk2 + IOC4Mk2, RLC16Mk2, CPUMMk2 + IOCNMk2). 

• VibroSight Capture supports the configuration and operation of the condition monitoring (CMS) functionality for 
a VM600Mk2 system (MPC4Mk2 + IOC4Mk2). 

• VibroSight Confgurator supports the configuration of VM600 systems (XMx16 + XIO16T) for condition 
monitoring (CMS) applications and the configuration of VibroSmart® systems (VSB30x + VSB300, 
VSI010 + VSB010) for machinery protection (MPS) and/or condition monitoring (CMS) applications. 

NOTE: Using separate VibroSight software modules – Protect and Capture – for the  
configuration and operation of VM600Mk2 functionality/systems helps ensure 
complete separation (“segregation”) of machinery protection (MPS) functionality 
and condition monitoring (CMS) functionality, when both are in a single 
VM600Mk2/VM600 rack (for example, as required by API 670). 

In this way, MPS and CMS configurations use separate tools with separate 
configuration files. So it is simply not possible for access/changes to a CMS 
(VibroSight Capture) to interfere in the operation of a MPS (VibroSight Protect) in 
the same VM600Mk2/VM600 rack, whether by accident or intent. 

(For reference, first-generation VM600 (VM600Mk1) machinery protection systems 
(MPSs) are configurated and operated using the VM600 MPSx software.) 
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The other existing VibroSight software modules are used for the operation and management of VM600Mk2 modules 
in the usual manner. For example, VibroSight Vision is used to display measurements from MPC4Mk2 + IOC4Mk2 
modules, while VibroSight System Manager is used to configure module Ethernet ports (IP addresses, etc.), update 
firmware, download log files, manage licensing and so on. 

 

VibroSight Capture and VM600Mk2 systems 

VibroSight Capture is the new VibroSight software module in VibroSight 7.0.0, featuring a modern and ultra-clear 
user-interface, designed for the configuration and operation of the condition monitoring (CMS) functionality for a 
VM600Mk2 system. 

VibroSight Capture is used to add condition monitoring (CMS) functionality to the VM600Mk2 MPC4Mk2 + IOC4Mk2 
module(s) in a VM600Mk2 system that has already been configured using VibroSight Protect. That is, the condition 
monitoring (CMS) configuration builds on the machinery protection (MPS) configuration (more specifically, the 
sensors / measurements chains and channels configured in VibroSight Protect). 

NOTE: It is important to note that when configuring a VM600Mk2 system for condition 
monitoring, the condition monitoring (CMS) configuration builds on the machinery 
protection (MPS) configuration. 
Therefore, VibroSight Protect must be used first in order to configure the complete 
VM600Mk2 system, including the MPC4Mk2 + IOC4Mk2 modules measurement 
channels and machinery protection (MPS) functionality, then VibroSight Capture 
must be used second in order to configure the MPC4Mk2 + IOC4Mk2 modules 
condition monitoring (CMS) functionality. 

 

 

With VibroSight Protect, the signal list (Excel file) typically required by a VM600Mk1 system is no longer needed. A 
VM600Mk2 system configuration can now be created directly by an end-user and then used by Meggitt to build the 
system (as a VibroSight Protect configuration file contains all of the required information). 

NOTE: VibroSight Protect is completely separate and distinct to VibroSight Capture and 
VibroSight Configurator in order to ensure the complete separation (“segregation”) 
of machinery protection and condition monitoring in a VM600Mk2/VM600 rack. 

 

 

VibroSight® and VM600Mk2 MPC4Mk2 condition monitoring system licensing 

In VibroSight® / VM600Mk2 systems (that is, the second generation of VM600 rack-based systems), the 
MPC4Mk2 + IOC4Mk2 module can provide machinery protection system (MPS) functionality and/or condition 
monitoring system (CMS) functionality, depending on the requirements of the application. 
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As already explained, the VibroSight® software uses completely separate software modules for the configuration 
and operation of VM600Mk2 systems depending on the functionality required: 

• VibroSight Protect supports the configuration and operation of the machinery protection (MPS) functionality for 
a VM600Mk2 system. 

• VibroSight Capture supports the configuration and operation of the condition monitoring (CMS) functionality for 
a VM600Mk2 system. 

 

Using separate software modules (VibroSight Protect and Capture) for the configuration and operation of VM600Mk2 
functionality/systems helps ensure complete separation (“segregation”) of MPS and CMS in a single 
VM600Mk2/VM600 rack. 

For example, a VibroSight® / VM600Mk2 system consisting of MPC4Mk2 + IOC4Mk2 modules can initially be installed 
and used as a MPS only. Then, CMS functionality can be quickly and easily added at any time by upgrading the 
licenses for the MPC4Mk2 + IOC4Mk2 module(s) and for VibroSight software, as required. 

 

For the VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module, machinery protection 
functionality is available by default for all versions of the module, while condition monitoring functionality is optional. 

Accordingly, MPC4Mk2 condition monitoring can be used by either (1) ordering a version of the module with 
condition monitoring enabled or (2) ordering and uploading a condition monitoring license to a version of the 
module without condition monitoring enabled (using VibroSight System Manager). 

See also 2.1.4 Managing condition monitoring licenses for VM600Mk2 MPC4Mk2 + IOC4Mk2 modules. 

 

NOTE: VM600Mk2 MPC4Mk2 condition monitoring also requires a VibroSight® software 
edition / license that supports condition monitoring. 
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2.1.1 VM600Mk2 MPC4Mk2 + IOC4Mk2 module – official launch of condition monitoring with new 
firmware and VibroSight software support  

VibroSight 7.0.0 introduces full support for condition monitoring using the VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery 
protection and condition monitoring module. This includes a new officially released version of condition monitoring 
firmware for the module (see 2.3 MPC4Mk2 + IOC4Mk2 module) and updates to the VibroSight software in order to 
support the configuration and operation of the condition monitoring system (CMS) functionality for the module – in 
addition to the existing support for machinery protection system (MPS) functionality for the module. 

 

In general, for VM600Mk2 MPC4Mk2 + IOC4Mk2 systems: 

• VibroSight Protect is used to configure VM600Mk2 systems (MPC4Mk2 + IOC4Mk2, RLC16Mk2, CPUMk2 + 
IOCNMk2) for machinery protection (MPS) applications. 

• VibroSight Capture is used to configure VM600Mk2 systems (MPC4Mk2 + IOC4Mk2) for condition monitoring 
(CMS) applications. 

• VibroSight System Manager is used for the operation and management of modules, as usual. 
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2.1.2 VibroSight Capture  

 

VibroSight Capture user interface 

When VibroSight Capture starts, the Welcome screen displays a view that allows the user to start a new VM600Mk2 
condition monitoring configuration (Start a new configuration), open an existing VM600Mk2 condition monitoring 
configuration file (Open Capture file) or connect to a running VM600Mk2 system (Connect to server). This is shown 
in Figure 1. 

 

 
Figure 1: VibroSight Capture Welcome screen 

 

Alternatively, the File menu command can be used to perform the same functions (New …, Open …, Connect …). 

For example, to start working on a new VM600Mk2 condition monitoring configuration, click the Machine train image 
under Start a new configuration. 
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When working on a VM600Mk2 condition monitoring configuration (new or existing), the VibroSight Capture user 
interface consists of five main tabs/pages, Machinery, Systems, Connect, Configure and Data, which are used as 
follows: 

 

• The Machinery tab/page is used for the configuration and display of general information (Machine train 
properties) important for the condition monitoring of the machinery being monitored, such as Layout, 
Reference speed, Direction of rotation, Reference direction, View direction. 
It is also used to visually define a machine train corresponding to the machinery being monitored using an 
embedded graphic library of machinery components (Machines, Bearings, Coupling, Shafts, etc.) and graphical 
user interface (GUI) framework. 
Note: The Machinery tab/page is roughly comparable to the Machinery view window in VibroSight Configurator. 
 

• The Systems tab/page is used to import data from an existing system to be used as the basis for the condition 
monitoring system. An existing VibroSight Protect configuration is typically used as the basis for a 
VibroSight Capture configuration, although data can also be imported from OPC devices. 

NOTE: It is important to note that when using VibroSight Capture to configure a VM600Mk2 
system for condition monitoring, the condition monitoring (CMS) configuration 
builds on the existing machinery protection (MPS) configuration, as defined using 
VibroSight Protect. 

 

• The Connect tab/page is used to establish links between the machine train defined on the Machinery tab/page 
and the system data imported via the Systems tab/page (for example, the sensors / measurements chains and 
measurement channels configured in VibroSight Protect). 
 

• The Configure tab/page is used to configure the individual condition monitoring measurements (Processing and 
Alarms), based on the imported machinery protection measurements, and to configure machine states 
(Machine states and/or Transient machine states), also known as machine operating conditions, for the 
machinery being monitored (Machine train). 
it is also used to configure overall parameters for the condition monitoring measurements, such as the 
condition monitoring update rate. 
Note: The Configure tab/page is roughly comparable to the Hardware view window in VibroSight Configurator. 
 

• The Data tab/page is used for the configuration and display of information related to the management and 
sharing of VibroSight data. 
VibroSight includes fully-integrated support for VibroSight database management that simplifies the 
configuration and operation of the database backup, database purge and management of offline data storage. 
(This extremely easy to use data management configuration means that no external data/database 
management tools are required.) 
Note: The Data tab/page is roughly comparable to the Data storage view window in VibroSight Configurator. 
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2.1.3 Getting started with VibroSight Capture – Adding condition monitoring to a 
VM600Mk2 MPC4Mk2 system 

Using VibroSight Capture to add condition monitoring to a VM600Mk2 MPC4Mk2 + IOC4Mk2 module requires a few 
simple steps: 

• In VibroSight Protect, create (and save) a machinery protection (MPS) configuration for the VM600Mk2 system. 

Remember, a VM600Mk2 system can consist of one or more MPC4Mk2 + IOC4Mk2 machinery protection and 
condition monitoring modules, optional RLC16Mk2 relay modules and an optional CPUMMk2 + IOCNMk2 rack 
controller and communications interface module. 

A VibroSight Protect configuration is saved as a *.mpscfg file. 

• In VibroSight Capture, to create and work with a condition monitoring (CMS) configuration for the VM600Mk2 
system: 

• Use the Machinery tab/page to visually define the machine train and define machine train properties. 

• Use the Systems tab/page to import data from the associated machinery protection system (MPS) 
configuration. 

• Use the Connect tab/page to connect the components (bearings, shafts, etc.) defined for the machine 
train to the measurement points (sensors / measurements chains) imported from the machinery 
protection (MPS) configuration. 

• Use the Configure tab/page to configure the condition monitoring measurements (processing), the 
machine states (for the machine train) and the condition monitoring update rate for the machinery 
being monitored. 

• Use the Data tab/page to configure the data management for the condition monitoring (CMS), such as 
data logging rules and database management (backups, purges, file storage and data export). 

• Save the configuration as a VibroSight Server (Note: As usual, an integrated Consistency checker can 
be used to help ensure the correctness of a configuration.) 

• Access the VibroSight Server using VibroSight Vision in order to display and analysis data in the usual 
way. 
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VibroSight Capture user interface – Machinery tab/page 

The Machinery tab/page is used to visually define the machine train and define machine train properties. This 
tab/page is shown in Figure 2. 

 

 
Figure 2: VibroSight Capture Machinery tab/page 

 

Machine train properties (left) is used to configure and display general information important for the condition 
monitoring of the machinery being monitored, such as Layout, Reference speed, Direction of rotation, Reference 
direction, View direction. 
 

The main window (centre) is used to visually define a machine train corresponding to the machinery being 
monitored using an embedded graphic library of machinery components and a graphical user interface (GUI) 
framework. 

For example, click on the Machine train “+” box (Figure 2) to display the Machinery components window and start 
to build the machine train. In the Machinery components window, select an individual component from Machines, 
Bearings, Couplings or Shafts and click Finish to add it to the machine train. 

When a component is added to the machine train, it’s “+” indicators can then be used in order to add/connect 
additional components. In this way, a machine train can be built/defined graphically. As an example, Figure 3 
shows a simple machine train that was built using a Machine – Compact, a Bearing – Radial rolling bearing, and a 
Shaft – Shaft notch. 
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Figure 3: VibroSight Capture Machinery tab/page – showing a simple machine train 

 

 

On the Machinery tab/page, as per most other VibroSight Capture tabs/pages: 

• The Machines window (right top) is used to add/remove items in the configuration. 

• The History window (right bottom) is used to undo/redo operations in the configuration. 

• Some other VibroSight Capture tabs/pages use a System window (right top) to select items in the 
configuration. 

Similar functionality is supported on other VibroSight Capture tabs/pages, where applicable. 

 

Also, there is a Consistency checks window (bottom) is common to all VibroSight Capture tabs/pages. 

Consistency checks are used to run and/or display consistency check information so that any problems in the 
VM600Mk2 system configuration can be corrected. 

Clicking on the Consistency check title bar displays/hides the consistency check window, as required. When the 
consistency check window is displayed, clicking the “play” icon (triangle in top left of window) will run the 
consistency checks and any issues will be reported as Errors, Warnings or Messages as appropriate. 

Double-clicking on a displayed issue will automatically take the user to the source of the problem in the 
configuration. 

The Consistency check title bar is displayed in purple if no problems are detected but is displayed in red if 
problems are detected. 
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VibroSight Capture user interface – Systems tab/page 

The Systems tab/page is used to import data from the associated machinery protection system (MPS) 
configuration. This tab/page is shown in Figure 2. 

 

 
Figure 4: VibroSight Capture Systems tab/page 

 

The main window (centre) is used to add system information, for example, by importing it an existing 
VibroSight Protect configuration. 

For example, click on the Add your first system “+” box (Figure 4) to display the new system window, then select 
Import protect file and use the dialog box that appears to navigate the folders on your computer and select the 
VibroSight Capture configuration file (*.mpscfg), then click Open, then click Finish to continue. 

VibroSight Capture will automatically import all of the required system information from the VibroSight Capture 
configuration file and refresh the main window to display the system as an icon (top left). As an example, 
see Figure 5. 

Clicking on an imported system icon will display the summary information for the system, equivalent to the Layout 
tab/page from VibroSight Protect. As an example, see Figure 6. When the summary information for a system is 
being displayed, clicking on Return to systems (main window, centre, top right) will return to the systems view 
(see Figure 5). 
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Figure 5: VibroSight Capture Machinery tab/page – with a VibroSight Protect system imported 

 

 
Figure 6: VibroSight Capture Machinery tab/ page – displaying the imported VibroSight Protect system information 
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VibroSight Capture user interface – Connect tab/page 

The Connect tab/page is used to connect the components (bearings, shafts, etc.) defined for the machine train to 
the measurement points (sensors / measurements chains) imported from the machinery protection (MPS) 
configuration. This tab/page is shown in Figure 7. 

 

 
Figure 7: VibroSight Capture Connect tab/page – with a machine train and an imported system 

 

When a machinery train has been defined via the Machinery tab/page and a system has been imported via the 
Systems tab/page, they will automatically appear on the Connect tab/page. 

The main window (top) displays the machine train, while the main window (bottom) displays the system information 
as an icon, as shown in Figure 7. 

Clicking on a system icon (bottom) will display the summary information for the system, in terms of modules and 
measurement channels. As an example, see Figure 8. When the summary information for a system is being 
displayed, clicking on Return to systems (main window, centre, top right) will return to the systems view 
(see Figure 7). 
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Figure 8: VibroSight Capture Connect tab/page – displaying the imported system information 

 

In order to establish connections/links between the components of the machine train and the measurement points 
(sensors / measurements chains) of the imported system, the system must be selected, that is, summary 
information displayed in terms of modules and measurement channels, as shown in Figure 8. 

Then for each connection to be made: 

• In the machine train (top), click on a component to select it. 

• In the system (bottom), click on a module’s input channel to select it. 

(Or vice versa, the order is not important.) 

• On the bar between the machine train (top) and the system (bottom), click Connect to connect/link the two 
selected (highlighted) elements. 

• NOTE: On the bar between the machine train (top) and the system (bottom), the Connect 
control becomes available when two compatible elements are selected. 

However, when two incompatible elements are selected, then the Connect control 
does not become available and a message is displayed, such as “The processing 
of a selected input channel is not compatible with the selected machine 
component”. For example, it is not possible to connect/link a bearing component 
and an auxiliary channel configured to measure speed (as speed must be 
measures on a shaft component such as a shaft projection, shaft notch or toothed 
wheel). 

 



 

Document reference VIBROSIGHT-RN/E (660-010-013-233A) 
Version 33 – 07.02.2022 

RELEASE NOTES 
VibroSight® 7.0.0 

25 / 84 
 

When a component of the machine train and an input channel are connected/linked: 

• A small icon is added close to the component on the image of the machine train (top) to indicate that there is 
now associated processing (measurements). 

• Selecting the component on the image of the machine train (top) will display the name of the processing, as 
defined in the imported system. 

• Selecting the component also displays a rubbish bin (trash can) icon that can be used to disconnect the link 
between the component of the machine train and the input channel. 

This is shown in Figure 9. 

 

 
Figure 9: VibroSight Capture Connect tab/page – selecting a machine train component to display 

additional information 

 

 

 



 

RELEASE NOTES 
VibroSight® 7.0.0 
26 / 84 

Document reference VIBROSIGHT-RN/E (660-010-013-233A) 
Version 33 – 07.02.2022 

 

VibroSight Capture user interface – Configure tab/page 

The Configure tab/page is used to configure the condition monitoring measurements (processing), the machine 
states (for the machine train) and the condition monitoring update rate for the machinery being monitored. This 
tab/page is shown in Figure 10. 

 

 
Figure 10: VibroSight Configure Connect tab/page – Machinery tab with the machine train title selected 

 

On the Configure tab/page, select the Machinery tab (top left), then select the Machine train title (top, centre) in 
order to display the Machine states controls (bottom, left), as shown in Figure 10. 

The Machine states controls allow Machine states and Transient machine states to be defined for the condition 
monitoring system. 

In the Machine states control (left), click + Machine state or + Transient machine state to add the type of machine 
state required, then use the main window (centre, bottom) to configure the parameters for the machine state, as 
necessary. 
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On the Configure tab/page, select the Machinery tab (top left), then select a machine train component on the image 
of the machine train in order to display all of the information for the processing and measurements (bottom) 
associated with the component, as shown in Figure 11. 

 

 
Figure 11: VibroSight Configure Connect tab/page – Machinery tab with a machine train component selected 

 

For the selected component/processing, the name and type of measurement is displayed (bottom, left), while more 
detailed information for the associated processing and measurements is displayed (bottom, centre) across three 
tabs: General, Processing and Alarms. 

The information displayed is a combination of: 

• The information imported from the associated machinery protection system (MPS) configuration, that is, the 
measurements (sensors / measurements chains, processing and alarms) imported from the VibroSight Protect 
configuration. 

• The default condition monitoring measurements (processing and alarms) that are automatically generated by 
VibroSight Capture, depending on the VibroSight Protect configuration. 

NOTE: It is important to note that any machinery protection system (MPS) information is 
displayed for information only and cannot be edited in VibroSight Capture. 
In general, such information is displayed as being unavailable (that is, greyed out). 

However, all condition monitoring system (CMS) information can be freely edited in 
VibroSight Capture, as required by the user. 
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For example, on the General tab (see Figure 12) none of the information displayed can be edited in VibroSight 
Capture, while on the Processing (see Figure 13) and Alarms tabs the information displayed under Machinery 
protection (top) cannot be edited but the information displayed under Condition monitoring (bottom) can be edited. 

 

 
Figure 12: VibroSight Configure Connect tab/page – General tab for a selected component/measurement 

 

 
Figure 13: VibroSight Configure Connect tab/page – Processing tab for a selected component/measurement 

 

Here, at the bottom of the tabs, the user can modify the default condition monitoring measurements (processing 
and alarms), as required. 
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On the Configure tab/page, select the System tab (top right), then select the system from the System window (top 
right) in order to display the general information for the system (MPC4Mk2 module), as shown in Figure 14. 

 

 
Figure 14: VibroSight Configure Connect tab/page – Machinery tab with a machine train component selected 

 

Here, at the bottom of the window, the user can modify the default Condition monitoring update rate for the system 
(MPC4Mk2 module) of 1 s, as required. 
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VibroSight Capture user interface – Data tab/page 

The Data tab/page is used to configure the data management for the condition monitoring (CMS), such as data 
logging rules and database management operations (backups, purges, file storage and data export). This tab/page 
is shown in Figure 15. 

 

 
Figure 15: VibroSight Configure Data tab/page 

 

On the Data tab/page, select one of the tabs (top) to see the window and configure the information relevant to the 
required data management operation: 

• Database logging rules 

• Database backup 

• Database purge 

• File storage 

• Sharing. 

 

NOTE: VibroSight includes fully-integrated support for VibroSight database management 
that simplifies the configuration and operation of the database backup, database 
purge and management of offline data storage. 
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For example, on the Database logging rules tab, click on the Add your first logging rule “+” box (Figure 15) to add 
and display a logging rule that can be configured in the main window (centre), as required. 

The Database backup, Database purge and File storage tabs are used similarly to configure database 
management operations for the database used by the VibroSight Server. 
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Activating a VibroSight Capture condition monitoring configuration on a VM600Mk2 system 

As the condition monitoring configuration for a VM600Mk2 system is being developed, the Consistency checks 
window (bottom) should be used to help correct any configuration errors and warnings as they occur, thereby 
helping ensure that a valid configuration is arrived at. 

Once a configuration has been created and/or changed, and there are no consistency check errors, a 
VibroSight Server must be created for the storage of the condition monitoring data and the configuration must be 
uploaded to the VM600Mk2 system in order to actually run on the system hardware (VM600Mk2/VM600 rack 
containing VM600Mk2 MPC4Mk2 module(s)). 

 

In VibroSight Capture, the File > Save as server menu command is used to create a VibroSight Server for the 
active condition monitoring configuration. 

Please note that the File > Save as server command is a one step process that automatically creates, starts and 
connects to the server – in order to initialise it, that is, upload and run the configuration. (For reference, this is 
different to VibroSight Configurator which uses a two step process, which requires that the VibroSight Server is 
created using one command and that the configurator is activated on the server using another command.) 

 

Figure 16 shows a VibroSight Server running a VM600Mk2 MPC4Mk2 condition monitoring. Success! 

 

 
Figure 16: VibroSight Server – being used for VM600Mk2 MPC4Mk2 condition monitoring 
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When a configuration running on a VibroSight Server is modified and it is required to use/apply these changes to 
update the configuration running on the server, then the File > Apply changes to active configuration menu 
command is used. 

When a configuration running on a VibroSight Server is modified and it is not required to use/apply these changes 
to update the configuration running on the server, then the File > Revert to active configuration menu command 
is used (to effectively discard any modifications/changes). 

 

NOTE: When activating a condition monitoring configuration on a VM600Mk2 system, the 
changes are applied to the VibroSight Server independently of whether the 
MPC4Mk2 modules are available or not. For modules not available on the network, 
an error message will be displayed by the server GUI (Log messages tab) every 
10-20-30-60-120 seconds. 
(For reference, when activating a machinery protection configuration on a 
VM600Mk2 system, all of the MPC4Mk2 modules contained in the configuration must 
be available.) 

 

 

Using condition monitoring data from a VM600Mk2 system 

Once the VibroSight Server is up and running, the measurement data from the condition monitoring configuration 
running on the VM600Mk2 MPC4Mk2 modules system is available for use by the other VibroSight software modules 
in the usual way. 

Notably, this includes VibroSight Vision for the display and analysis of condition monitoring data. 
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VibroSight System Manager and VM600Mk2 systems 

For VM600Mk2 systems, VibroSight System Manager is used to display information about VM600Mk2 modules 
(MPC4Mk2 + IOC4Mk2, RLC16Mk2, CPUMk2 + IOCNMk2). 

 

In the System Explorer window (left), MPC4Mk2 + IOC4Mk2 modules are listed under MPC4 modules and 
CPUMMk2 + IOCNMk2 modules are listed under CPUM modules and. 

In general, for VM600Mk2 modules in VibroSight System Manager, functionality is available from the Actions window 
(right) and general information is displayed in the main window (centre). 

 

For example, as shown in shown in Figure 17 (centre), under General Information, this includes the following 
information relevant to machinery protection and condition monitoring: 

• Machinery protection status 

• Condition monitoring status 

• Condition monitoring licensing status. 

 

 
Figure 17: VibroSight System Manager – information and actions for a MPC4Mk2 module 

 



 

Document reference VIBROSIGHT-RN/E (660-010-013-233A) 
Version 33 – 07.02.2022 

RELEASE NOTES 
VibroSight® 7.0.0 

35 / 84 
 

Figure 17 (right) also shows the various actions/tasks that VibroSight System Manager can perform for MPC4Mk2 
modules, notably: 

• Maintenance: Changing firmware, Test LED (module identification in a rack) and Proof test. 

• Configuration: Configuration of IP and NTP settings. 

• Diagnostics: Download of diagnostics log. 

• Licensing: Set licence, Remove licence and Save device info. 

 

See also 2.1.3 Getting started with VibroSight Capture – Adding condition monitoring to a VM600Mk2 MPC4Mk2 
system. 
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2.1.4 Managing condition monitoring licenses for VM600Mk2 MPC4Mk2 + IOC4Mk2 modules 

VibroSight System Manager is used to display information about and manage condition monitoring licenses for 
VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring modules. 

 

To display information about the condition monitoring license for a VM600Mk2 MPC4Mk2 + IOC4Mk2 module in 
VibroSight System Manager: 

1. Start VibroSight System Manager. 

2. In the System Explorer window (left), select Devices (bottom) so that the VibroSight compatible devices 
available to the computer are displayed. 

3. From the list of available MPC4 modules, select the MPC4Mk2 module (identifiable by its serial number 
xxxxxxx). 

4. The main window (centre) updates to display information for the MPC4Mk2 + IOC4Mk2 module. 
Under General information (top), Condition monitoring licensing status indicates the status of the condition 
monitoring license for the MPC4Mk2 + IOC4Mk2 module: Valid license or No license. 

 

When the MPC4Mk2 + IOC4Mk2 module has a valid condition monitoring license, under General information, 
Condition monitoring status indicates the status of the condition monitoring for the MPC4Mk2 + IOC4Mk2 module: 
Running or Not configured. 

 

When the MPC4Mk2 + IOC4Mk2 module does not have a valid condition monitoring license, under 
General information, Condition monitoring status will indicate that condition monitoring is not possible for the 
MPC4Mk2 + IOC4Mk2 module: There is no condition monitoring license. To purchase a license please contact 
your Meggitt sales representative. 

 

To activate (set) a condition monitoring license for a VM600Mk2 MPC4Mk2 + IOC4Mk2 module in 
VibroSight System Manager: 

1. Start VibroSight System Manager. 

2. In the System Explorer window (left), select Devices (bottom) so that the VibroSight compatible devices 
available to the computer are displayed. 

3. From the list of available MPC4 modules, select the MPC4Mk2 module (identifiable by its serial number 
xxxxxxx). 
The main window (centre) updates to display information for the MPC4Mk2 + IOC4Mk2 module. 

4. In the Actions window (right), under Licensing, click Set license and use the dialog box that appears to 
navigate the folders on your computer and select the License file (*.lic), then click Open, then click Next. 
After which, VibroSight will install (upload) the condition monitoring license to the MPC4Mk2 module. Click 
Finish to continue. 

When the main window (centre) is refreshed, it will display updated information for the MPC4Mk2 + IOC4Mk2 module. 
For example, under General information (top), Condition monitoring licensing status will indicate the status of 
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the condition monitoring license for the MPC4Mk2 + IOC4Mk2 module as: Valid license when a valid license has 
been activated (set / uploaded to the module. 

NOTE: In VibroSight System Manager, the main window (centre) updates automatically 
(every 10 s approx.) or manually, for example, whenever a module is (re)selected 
in the System Explorer window. 

 

Similarly, VibroSight System Manager can also be used to clear (remove) a condition monitoring license for a 
VM600Mk2 MPC4Mk2 + IOC4Mk2 module by using the Remove license control in the Actions window (right). 

 

 

2.2 Inter-process communication – gRPC 

The VibroSight software has been improved with the migration of its inter-process (client-server) communication 
library to use gRPC, a high-performance, open source universal RPC (remote procedure call) framework. 

For example, gRPC is now used to support communication between a VibroSight Server and clients such as 
VibroSight Vision and VibroSight Mimic, and communication between VibroSight and other servers such as a 
VibroSight Modbus Server or a VibroSight OPC Server. 

The migration to gRPC has been implemented in order to: 

• Improve performance, reliability and security. 

• Increase interoperability and extensibility. 

 

With the migration to gRPC, it is important to note the following about the IP ports used by VibroSight 7.0: 

• VibroSight Server 

The default TCP port number used by a VibroSight Server (Xms.Server.Client.exe) is 55 000. 
Although any port in the range 55 000 to 55 020 can be used. 

TCP port binding can be used to ensure that a VibroSight Server always uses a particular TCP port. 
This is done by manually editing the configuration file for the server, typically available here: 
\VibroSight data\<HDF database folder>\Storage\ServerConfiguration\EditableServerConfiguration.xml 

In the configuration file: 
<Property Name="TcpIpPort" Value="55000" … should be changed to the required port number. 
<Property Name="IsTcpIpPortFixed" Value="false" … should be changed to “true”. 

• VibroSight Host Service 

The default TCP port number used by the VibroSight Host Service (XmsHostService.exe) is 50 000. 

TCP port binding can be used to ensure that the VibroSight Host Service always uses a particular TCP port. 
This is done by manually editing the configuration file for the host service, typically available here: 
C:\Program Files\Meggitt\VibroSight\Bin\ XmsHostService.exe.config 
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In the configuration file: 
<add key="Port" value="50000" … should be changed to the required port number. 

• VibroSight Modbus Server 

The default TCP port number used by a VibroSight Modbus Server is 60 000. 

TCP port binding can be used to ensure that a VibroSight Modbus Server always uses a particular TCP port. 
This is done by manually editing the configuration file for the server (*.vssrvcfg) in order to change the 
"Port" to the required port number. 
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VM600Mk2 modules 

2.3 MPC4Mk2 + IOC4Mk2 module 

Updated VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module firmware with the 
following main improvements: 

 

Machinery protection firmware: 640-025-005-000 

NOTE: VM600Mk2 MPC4Mk2 machinery protection firmware (640-025-005-000) is only 
compatible with MPC4Mk2 modules with PNR 600-041-000-002. 

Uploading this machinery protection firmware (640-025-005-000) to MPC4Mk2 
modules with PNR 600-041-000-001 will result in a module stuck in the Power-up 
operating mode. 

 

• RMS measurement improvements 
The algorithms used to compute “True RMS” and “True Average” measurements have been improved. Some 
oscillations observed at certain frequencies have removed and some instabilities seen during frequency 
changes have also been improved. 

• LP filter creation errors 
Some low-pass (LP) filter parameters were not being accepted by the module. 

• Outputs shall change only after a stabilisation period 
During power-up, the modules outputs (4-20 mA, relays, VibroSight interface) are now held in their default state 
until the stabilisation period is over. 
Note: The stabilisation period can be increased by the user via the Delay NOK to OK. The longest sensor / 
measurement chain delay becomes the stabilisation period. 

• Removal of HP filter 400 Hz cutoff limitation 
The high-pass (HP) filter is no longer limited to 400 Hz max. 

• Extended windows for protection 
The signal-processing window functions (Window types) supported for machinery protection now include 
Blackman, Blackman-Harris and Tukey α=0.5. 

• Added infrastructure for condition monitoring support 
The MPC4Mk2 module can now run the machine protection firmware (FW) and the condition monitoring 
firmware (FW) in parallel. 
Importantly, the condition monitoring firmware (FW) runs at a lower priority and there is complete separation 
(“segregation”) between the two. 
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As the latest version of VM600Mk2 MPC4Mk2 machinery protection firmware (640-025-005-000) is only compatible 
with MPC4Mk2 modules with PNR 600-041-000-002, the previous version of the module firmware 
(640-025-004-000) has also been updated in order to create firmware (640-025-004-003) that is compatible with 
MPC4Mk2 modules with PNR 600-041-000-001 and PNR 600-041-000-002. However, this version of machinery 
protection firmware (640-025-004-003) does not support condition monitoring on the MPC4Mk2 module. 

 

Machinery protection firmware: 640-025-004-003 

NOTE: VM600Mk2 MPC4Mk2 machinery protection firmware (640-025-004-003) is 
compatible with MPC4Mk2 modules with PNR 600-041-000-001 (that is, previous 
versions of the module hardware) and PNR 600-041-000-002 (that is, the latest 
version). 

However, using this version of machinery protection firmware (640-025-004-003) 
will result in a module that supports machinery protection only. More specifically, 
machinery protection firmware (640-025-004-003) is not compatible with the 
condition monitoring firmware (640-033-vvv-ppp). 

 

• Machinery protection firmware (640-025-004-003) features all of the same main improvements as machinery 
protection firmware (640-025-005-000) – except for the “Added infrastructure for condition monitoring support”. 

 

 

Condition monitoring firmware: 640-033-001-000 

NOTE: VM600Mk2 MPC4Mk2 condition monitoring firmware (640-033-001-000) is only 
compatible with machinery protection firmware (640-025-005-000), that is, 
MPC4Mk2 modules with PNR 600-041-000-002 or later. 

 

• Initial release 
VM600Mk2 MPC4Mk2 condition monitoring firmware (640-033-001-000) is the first release of condition monitoring 
firmware for MPC4Mk2 modules and adds condition monitoring system (CMS) functionality to 
VibroSight / VM600Mk2 MPC4Mk2 systems. 

• License required 
For the VM600Mk2 MPC4Mk2 + IOC4Mk2 machinery protection and condition monitoring module, machinery 
protection (MPS) functionality is available by default for all versions of the module, while condition monitoring 
(CMS) functionality is optional. 
Accordingly, in order for a VM600Mk2 MPC4Mk2 module to run any condition monitoring firmware 
(640-033-vvv-ppp) and support condition monitoring (CMS) functionality, a condition monitoring license is 
required for the MPC4Mk2 + IOC4Mk2 module. 
See also 2.1.4 Managing condition monitoring licenses for VM600Mk2 MPC4Mk2 + IOC4Mk2 modules. 
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Recovery firmware: 640-031-003-006 

• Various small improvements and bug fixes 

• Compatibility with VibroSight 7.0. 

 

 

Proof test firmware: 640-032-001-001.VxeFw  

NOTE: VM600Mk2 MPC4Mk2 proof test firmware (640-032-001-001) is only compatible with 
recovery firmware (640-031-003-006). 

 

• IOC4G2 Error not reported correctly 
Some measurement errors on the IOC4Mk2 were not being reported correctly. 

• RTOS timer test sometime failing 
The real-time operating system (RTOS) test was sometimes failing due to an incorrect wrong measurement of 
the OS timer. 

 

See also 2.1 Support for VM600Mk2 – the next generation of VM600 machinery protection and condition monitoring 
system and 5.2 VM600Mk2/VM600 modules/cards. 

 

 

2.4 CPUMMk2 + IOCNMk2 module 

Updated VM600Mk2 CPUMMk2 + IOCNMk2 rack controller and communications interface firmware with the following 
main improvements and bug fixes: 

 

Base-system / Applications firmware: 640-031-001-001 

• I2C bus hanging in multi-master mode 

• Spurious reboots of the CPUMMk2. 

 

See also 5.2 VM600Mk2/VM600 modules/cards. 
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VM600 modules 

2.5 CPUR2 + IOCR2 module 

Updated VM600 CPUR2 + IOCR2 rack controller and communications interface firmware with the following main 
improvements and bug fixes: 

 

Base-system firmware: 640-014-001-005 and Applications firmware: 640-015-001-005 

• Support for latest version of module hardware (compatible with the previous version) 

• Modbus server connection handling enhancements 

• Added support and management for VME bus deactivation 

• Added support to force detection of VM600Mk2/VM600 XMC16 modules. 

 

See also 5.2 VM600Mk2/VM600 modules/cards. 
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3 Solved problems and bug fixes 

3.1 General improvements and bug fixes 

General stability improvements and bug fixes across the VibroSight 7.0.0 software. 

 

3.2 Events selected for logging are not persisted 

In VibroSight Configurator, in the Data storage view, the Event entities selected for an Events data logging rule did 
not persist. That is, after the configuration was activated, the Event entities were no longer listed in the 
configuration as selected. 

 

3.3 Crash in Scope when configuration contains a dual processing block 

In VibroSight Scope, when working with a VibroSmart VSV30x module configured with a Dual shaft relative 
processing block, VibroSight Scope experienced an “unexected error” and crashed (stopped working) when 
attempting to select the module as a data source. 

 

3.4 Changing server passwords from the System Manager fails 

In VibroSight System Manager, in the System Explorer view (VibroSight Hosts), when connected to a 
VibroSight Server and attempting to change the server’s passwords, VibroSight System Manager experienced an 
“unexected error” and crashed (stopped working). 

 

3.5 In Protect, when activating a configuration with a channel referencing another one, protect 
crashes when activating the configuration 

In VibroSight Protect, when working with a VM600Mk2 MPC4Mk2 module configured with a dynamic measurement 
channel that uses an existing signal input as its signal input (that is, a dynamic measurement channel that is linked 
to an existing channel in order to use the same sensor / measurement chain), VibroSight Protect experienced an 
“error” and crashed (stopped working) when attempting to activate the machinery protection configuration on the 
module. 

 

3.6 In the server the VibroSmart component cannot be started 

For a VibroSight Configurator configuration containing VibroSmart modules, after the configuration is saved as a 
server / database, the VibroSmart components of the VibroSight Server could not be started as expected and an 
“exception” was raised. 
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3.7 In Protect, validation of adaptive monitoring band values not always triggered when 
editing values 

In VibroSight Protect, configuring a measurement channel Alarm to use Adaptive monitoring with Trip multiplier 
bands was not easy as the displayed hint text was not always clear and/or correct, sometimes the validation of the 
entered vales was not triggered, and sometimes incorrect text (error messages) continued to be displayed even 
when the entered values were correct. 

 

3.8 Protect remains blocked and must be killed after activating the configuration 

In VibroSight Protect, under certain circumstances, after activating the machinery protection configuration on 
VM600Mk2 MPC4Mk2 module(s) (that is, System activation), VibroSight Protect would become unavailable/blocked 
and would have to be “killed”, for example, using a Task manager End task command. 

 

3.9 VibroSight Server - Data logging stops 

For a VibroSight Server running as a Windows service and being operated via VibroSight System Manager, the 
data logging stopped infrequently without any user intervention. This issue was further characterised by live data 
continuing to be available via VibroSight Mimic and VibroSight Vision as usual, even though data logging by the 
database had stopped. 

 

3.10 Protect displays Raw bus connections in OC bus view 

In VibroSight Protect, when working with a VM600Mk2 system configuration consisting of MPC4Mk2 and RLC16Mk2 
modules, when RLC16Mk2 logical functions were created using the Raw bus for inter-module signalling, these 
signals/lines were correctly displayed on the Raw bus but were also incorrectly displayed on the OC bus, in the 
Bus view (on the Layout tab/page). 

 

3.11 When adding a new Mathematical function processing block no existing input channels 
are available in the "Existing signal input" tab 

In VibroSight Protect, when working with a VM600Mk2 MPC4Mk2 module and attempting to configure Dual 
mathematical function (DMF) processing (that is, Processing type: Dual, Sensor family: Any sensors and 
Mathematical function), after having select the Processing (Sensor family: Pressure sensors, Processing: Broad-
band pressure) for the individual channels and being prompted to select the Signal input, the Existing signal input 
tab was blank/empty. 
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3.12 Issues displaying card data in the Protect dashboard when the computer is directly 
connected to that card 

In VibroSight Protect, when working with a VM600Mk2 system consisting of two MPC4Mk2 modules which are 
connected to the computer running VibroSight via a network/switch and after having activated the system, if the 
network connections to the MPC4Mk2 modules were replaced by a single direct connection between the computer 
and each of the modules in turn, then communications with one of the modules was possible and data could be 
displayed in the VibroSight Protect Dashboard tab/page as expected but communications with the other module 
was not possible (that is, communications became “blocked”). 

 

3.13 Protect - wrong temp values in dashboard for input channels using current mode 

In VibroSight Protect, when a measurement channel (dynamic or auxiliary) was configured with 
Sensor family: Temperature sensors and Processing: Quasi-static temperature, and with a current input for 
operation with a current-based temperature sensor (sensitivity: xx µA/°C, output range: 4 to 20 mA), incorrect 
temperature values were displayed from the running system by the VibroSight Protect Dashboard tab/page and by 
VibroSight Vision, probably due to incorrect conversions between K (as used internally by VibroSight for 
temperature) and °C. 

 

3.14 In the Configurator an exception occurs when adding a new slot to a Profibus 

For a VibroSight Configurator configuration containing VibroSmart VSV30x and VSI010 modules, when adding a 
PROFIBUS port to the VSI010 module’s communication interfaces, after a New slot is defined and it was attempted 
to select and add all data entities to the slot, VibroSight Configurator experienced an “unexected error” and crashed 
(stopped working). 
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4 Known issues 

4.1 Display of timestamps in VibroSight Vision 

In VibroSight Vision, when the timestamps (date and time) are configured to be displayed as Site time or Local 
computer time and the site time or local computer time is subsequently changed on the relevant computer (for 
example, using Windows > Control Panel > Date and Time), this change is not reflected in the VibroSight Vision 
user interface until the user clicks on the Timestamp displayed in the VibroSight Vision status bar. 

 

 

4.2 VibroSight Server and Host Service restart required after changes to network adapter 

If the configuration of a network adapter is changed (for example, enabled or disabled, connected or disconnected) 
on a computer running VibroSight, then the VibroSight Servers and Host Services running on the computer must 
be restarted in order for the network adapter to be recognized by the VibroSight discovery mechanism. 

 

 

4.3 Length limitation of VibroSight Server instance names 

Since VibroSight 2.9.6, VibroSight Server instance names are limited to 18 characters, whereas up to 
27 characters were allowed in previous versions. This constraint is enforced during the creation of new server 
instances with VibroSight 2.9.6 or later. 

NOTE: VibroSight allows only alphanumeric characters (A to Z, a to z, 0 to 9), the 
hyphen-minus character ( - ) and the underscore character ( _ ) to be used for 
VibroSight Server names. 

 

However, existing server instances may be non-compliant (too long) and no longer run after an upgrade of the 
VibroSight software. In such cases, the file names used for a VibroSight Server database file (*.vssrvdb or *.db) 
and a VibroSight Server configuration file (*.vssrvcfg or *.config) should be updated (and manually edited in the 
VibroSight configuration file) to be 18 characters or less. Changes may also be required in any VibroSight software 
that references the server instance name, such as VibroSight Vision projects. 

Where used, the automated data management commands and operations that append a timestamp 
(_yyyyMMddHHmmss) to the Server instance name reduces the number of file name characters that remain 
available for VibroSight Server instance names to three. Alternatively, the server instance name can be shorted 
after the data repository command or operation is complete. 

Also, depending on the VibroSight Server data repository (database) file names used and any truncation performed 
by VibroSight, it is possible that servers are created with names that contain non-allowed characters (such as 
spaces), with the result that these servers will not be accessible by VibroSight software clients. Similarly, duplicate 
VibroSight Server names are also possible. 

 



 

Document reference VIBROSIGHT-RN/E (660-010-013-233A) 
Version 33 – 07.02.2022 

RELEASE NOTES 
VibroSight® 7.0.0 

47 / 84 
 

NOTE: Choose appropriate VibroSight Server names in order to avoid name conflicts 
arising due to truncation and/or additional data repositories being created during 
automatic data management. 

This is particularly important for systems with automated data management and 
system backup procedures that can generate VibroSight Server data repositories 
with different file names. 

 
 

4.4 Display of timestamps in VibroSight clients other than VibroSight Vision 

Although VibroSight Vision now supports the display of timestamps (date and time) as either Site time, UTC time or 
Local computer time, all other VibroSight client software modules continue to display timestamps in local computer 
time only (that is, the date and time according to the local clock of the computer running the VibroSight software 
module). 

 
 

4.5 Display of devices in VibroSight System Manager 

In the System Explorer window of VibroSight System Manager, the Devices tree-view does not always update 
correctly to show all of the devices (VM600 modules/cards and VibroSmart devices) available on the network. 

In particular, this has been seen when changing the firmware of a device, and can persist even after a refresh 
(using the Refresh toolbar button or View > Refresh). 

If this behaviour is seen, the recommended workaround is to: 

• Wait a few minutes and refresh again. 

• Restart VibroSight System Manager. 

 
 

4.6 VibroSight Mimic backwards compatibility 

VibroSight 2.10.0 contained significant improvements and changes, including a separate VibroSight Mimic client 
software module for mimics (that were previously available in VibroSight Vision). As a result, VibroSight Vision 
mimics created with VibroSight 2.9.7 or earlier are not compatible with VibroSight 2.10.0 or later. 

VibroSight 2.11.0 contained significant improvements and changes to the VibroSight Mimic client software module. 
As a result, VibroSight Vision mimics created with VibroSight 2.10.1 or earlier are not compatible with VibroSight 
2.11.0 or later. 

VibroSight 2.11.5 contained significant improvements to the VibroSight Mimic project framework to include version 
information, in order to improve the compatibility between projects created with different versions of VibroSight 
Mimic and eliminate the requirement for the recreation of Mimics. Starting with VibroSight 2.11.5, Mimic projects 
automatically detect any changes in the VibroSight Mimic software that affect project compatibility, inform the user 
and update the project as required. 
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NOTE: VibroSight 2.11.5 is also able to open and work with Mimic projects created with 
VibroSight 2.11.0 or later, if the corresponding database had been updated as 
required. 

 

NOTE: When updating existing machinery monitoring projects created with 
VibroSight 2.12.x to VibroSight 3.x.x or later, a new data repository created by 
copying a VibroSight database (*.vssrvdb) to a VibroSight historical data folder 
(*.vshdf) must use the same server file name as the existing server in order for 
existing VibroSight Mimics to maintain links with the data repository and continue to 
work (without manual corrections). 
In addition, the VibroSight Server using the new data repository must be running 
before the existing VibroSight Mimics are run for the first time, after the update. 

 
 

4.7 VibroSight OPC Clients not recovering 

When a VibroSight OPC Client is being used to import information from an external OPC server into a VibroSight 
system and the external OPC server becomes unavailable, the VibroSight OPC Client may not always recover 
automatically when the OPC server becomes available again. 

This is typically characterised by the VibroSight OPC Client continuing to show connection error messages even 
when OPC server is available and can result in permanent loss of the imported data if not noticed. 

NOTE: The external OPC data can be permanently lost if it is not imported into VibroSight 
as expected. 

Any VibroSight system feature or configuration element relying on the imported 
OPC data will not behave as expected, for example, alarms, machinery operating 
conditions and data logging rules. 

 

If this behaviour is seen, the recommended workaround is to: 

• Stop and restart the VibroSight OPC Client from either the VibroSight Server 
(Data > Acquisition > OPC Device Driver) or VibroSight System Manager. 

• Stop and restart the VibroSight Server, if required. 

 
 

4.8 Duplicate events 

For VibroSight systems using VM600 XMx16 cards, VibroSight Event Viewer retrieves all of the event information 
available from the data buffers on the cards. 

For VibroSight systems using VibroSmart modules, VibroSight Event Viewer retrieves the event information 
available from the current time only (no buffered events). 
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Accordingly, for a VibroSight system using VM600 XMx16 cards, there is the possibility of duplicate events being 
listed in the Event Viewer, particularly for VibroSight systems being operated without an NTP server (where events 
are not recognised as duplicates due to time drift). 

 
 

4.9 VibroSight Server status indicators 

The status indicators (performance counter monitors) on the Status tab of the new VibroSight Server are not 
correctly displayed and updated when an NVIDIA WMI driver is installed on the same computer as the VibroSight 
Server. 

NOTE: The NVIDIA Enterprise Management Toolkit (NVWMI) is a graphics and display 
management and control technology that interfaces to Microsoft’s Windows 
Management Instrumentation (WMI) infrastructure, specific to NVIDIA graphics 
processing units (GPUs). 

 
This is because NVIDIA WMI prevents the Microsoft .NET Framework from obtaining the required counter values 
from the underlying operating system / computer. 

 
 

4.10  XMx16 card pre-logging 

For an XMx16 card pair, if Dynamic Input Channel 16 is used as an input to a Dynamic Processing Block that is 
used as an input to a Dual Shaft Relative Processing Block which is configured to provide an Orbit and/or Full 
Spectrum output, then any pre-logging configured for the principal mode Waveform and/or Spectrum of Dynamic 
Input Channel 16 will not actually log any of the data from the same pre-logging scope. 

 
 

4.11  Problems creating new VibroSight OPC Classic Servers 

Users who have upgraded from an earlier version of VibroSight to a later version (for example, from 
VibroSight 2.x.x or 3.0.0 to VibroSight 3.1.0) can experience problems when creating new VibroSight OPC Classic 
Servers. 

Such problems are typically characterised by the OPC Server Create command in VibroSight System Manager 
displaying an error message such as 
“The type initializer for ‘ch.VibroMeter.Xms.OpcServer.Utils.OpcServerUtils’ threw an exception”. 

This typically occurs because an earlier version of the OpcServer.config file required by VibroSight OPC Classic 
Servers is being used by the later installation of VibroSight, which can happen in one of two ways: 

• When a version of VibroSight 3.x.x or later is installed on a computer that was running a version of 
VibroSight 2.x.x or earlier, the VibroSight installer automatically checks existing VibroSight folders (such as 
C:\ProgramData\Meggitt\VibroSight 2) in order to copy relevant system and/or user preference files across to 
the new VibroSight folders (such as C:\ProgramData\Meggitt\VibroSight), including an earlier 
OpcServer.config file. 
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• When VibroSight 3.1.0 is installed on a computer that was running VibroSight 3.0.0, the creation of a 
VibroSight OPC Classic installer using VibroSight 3.0.0 automatically created an earlier OpcServer.config file. 

As shown below, the first few lines of a typical OpcServer.config file contains version specific information that is 
incompatible with later versions of VibroSight: 

<?xml version="1.0" encoding="utf-8"?> 

<configuration> 

  <configSections> 

    <section name="opcServersConfiguration" type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 
XmsOpcServerUtils, Version=2.0.0.0, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

  </configSections> 

… 

</configuration> 

 

So for users who have upgraded from an earlier version of VibroSight to a later version, if problems are 
experienced when creating new VibroSight OPC Classic Servers, the workaround is to: 

 

1. Use an XML-compatible text editor program to edit the OpcServer.config file and remove the version specific 
information. That is, change the line containing the section name 
from: 

<section name="opcServersConfiguration" type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 
XmsOpcServerUtils, Version=2.0.0.0, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

to: 

<section name="opcServersConfiguration" type="ch.VibroMeter.Xms.OpcServer.Utils.OpcServersSystemConfiguration, 
XmsOpcServerUtils, Culture=neutral, PublicKeyToken=2db2a2387bac0a0a" /> 

 

2. Restart the computer. 
    Note: The computer must be restarted to ensure that the edited version of the OpcServer.config 
    file is used (and not some other version from cache memory). 

 

3. Use the OPC Server Create command in VibroSight System as required. 

 

NOTE: The manual migration of existing VibroSight OPC Classic Servers to 
VibroSight 3.x.x or later is described in detail in the “VibroSight OPC Classic Server 

migration” section of the latest  Getting started with VibroSight installation 
guide. 
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4.12  Potential TCP port 50000 conflict 

The VibroSight Host Service (XmsHostService.exe) requires TCP port 50000 for communication with the 
VibroSight software. So if the computer running the VibroSight software is running other software which also 
requires TCP port 50000, this results in a TCP port conflict which can prevent VibroSight (or the other software) 
from running. 

During the VibroSight software installation process, the VibroSight 3.4.x or later installer will typically detect other 
software on the computer that is using TCP port 50000 and report this. For example: “The port 50000 cannot be 
used. Please close all application using this port before manually starting the host service.” 

Accordingly, any potential TCP port 50000 conflicts should be resolved before the VibroSight software can be 
successfully installed and run. 

 

 

4.13  Problems using shared network drives/locations for VibroSight data management 

On computers running Windows 10 or Windows Server 2016, problems can be experienced using shared network 
drives/locations with VibroSight’s integrated data management operations such as Offline data storage and 
Database backup (configured in VibroSight Configurator) due to Windows security policies and restrictions. 

Such problems are typically characterised by the individual copy commands scheduled and run on a VibroSight 
Server (corresponding to Offline data storage and Database backup operations) failing to run correctly. More 
specifically, on the Data Management tab of a VibroSight Server, scheduled incremental copy jobs (Type: Copy) 
are typically displayed with Status: Error, while the Log Messages tab of the server display typically displays 
messages such as “Errors during the copy operation” and “Uncaught error IOException occurred in task ‘Task 
“DataRepositoryCopyDataMan…”. 

NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 
with a change to the rules governing shared network drives/locations. 
More specifically, a shared network drive/location is now only accessible and 
visible to the user who created the shared network drive/location, even if the user is 
an Administrator. 

 

Accordingly, in order to avoid such problems, a shared network drive/location on Windows 10 and 
Windows Server 2016 computers that is required to be used by VibroSight’s integrated data management 
operations should be created as a “system account” in order to ensure that the required Windows Services can 
access the shared resource (drive/location). 

This can easily be done using Microsoft’s PsExec utility. For example, by running the following command (as an 
Administrator): 

PsExec.exe -i -s cmd.exe /C "net use Z: \\server\share"  

Where the net use command is used to map the \\computer name\sharename (\\server\share) to the devicename 
(Z:). 

 

https://docs.microsoft.com/en-us/sysinternals/downloads/psexec
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NOTE: For Windows 10 and Windows Server 2016, Microsoft improved network security 
with a change to the rules governing shared network drives/locations. 
More specifically, a shared network drive/location is now only accessible and 
visible to the user who created the shared network drive/location, even if the user is 
an Administrator. 

 

 

4.14  Problems installing VibroSight 3.7.x on computers without internet access 

On computers which are not connected to the internet, the VibroSight 3.7.x installer can experience problems when 
automatically installing the prerequisite Microsoft Visual C++ Redistributable Package for Visual Studio 2015, and 
report a generic message such as “Setup Failed. One or more issues caused the setup to fail”. 

As a workaround, trying to manual install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015, 
the Microsoft Visual C++ installer can also experience problems, and report a similar generic “Setup Failed” 
message. 

This is a known Microsoft problem which is due to some components in Visual Studio being signed by a 
certification authority that is not installed on the computer, and the computer cannot automatically download the 
required certificate(s) because it is not connected to the internet. 

Accordingly, the Microsoft solution is to: 

1. On a computer which is connected to the internet, download the following certificate: 
http://www.microsoft.com/pki/certs/MicRooCerAut2011_2011_03_22.crt  
Then copy the certificate to the VibroSight computer (for example to C:\Temp). 

2. On the VibroSight computer, use the certmgr.exe utility to add the certificate by using the command line. 
Note: For more information, refer to the Certmgr.exe (Certificate Manager Tool) topic at MSDN. 

3. Open an admin command prompt and run the following command: 
certmgr.exe /add C:\Temp\MicRooCerAut2011_2011_03_22.cer /s /r localMachine root 

4.  Next, try installing the patch KB3135996 or KB3136000. 

 

If required, additional information is available from a Microsoft MSDN blog, here: 
https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-
authority-2 

 

 

  

https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-authority-2
https://blogs.msdn.microsoft.com/vsnetsetup/2016/03/28/a-certificate-chain-could-not-be-built-to-a-trusted-root-authority-2
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5 Compatibility 

As part of the VibroSight software installation process, the VibroSight installer will automatically check to see if the 
required Microsoft .NET Framework, Microsoft Visual C++ Redistributable Package, OPC Core Components 
Redistributable software and OPC UA Local Discovery Server are pre-installed on the computer: 

• The required Microsoft Visual C++ Redistributable Package (see section 5.1.3) must be manually installed 
before VibroSight can be installed. If it is not detected, then the VibroSight installer will exit the installation and 
VibroSight is not installed. 

• The required Microsoft .NET Framework (see section 5.1.2) is automatically installed by the VibroSight installer 
if it is not detected. 

• The required OPC Core Components Redistributable (see section 5.1.4) software is automatically installed on 
the computer by the VibroSight installer if it is not detected. 

• The required OPC UA Local Discovery Server (see section 5.1.5) software is automatically installed on the 
computer by the VibroSight installer if it is not detected. 

NOTE: Refer to the latest version of the  Getting started with VibroSight installation 

guide or the  VibroSight software data sheet for further information on 
VibroSight’s prerequisites and compatibility. 

 

 

5.1 VibroSight software 

VibroSight 7.0.0 is a major level release and replaces VibroSight 6.1.x. 

Compatibility with existing VibroSight data repositories (databases) is achieved using a specific data migration 
process from any existing databases based on Sybase SQL Anywhere (*.vssrvdb) to data repositories based on 
the VibroSight historical data repositories (VibroSight historical data folder (*.vshdf) for operation with a VibroSight 
Server (live data) and VibroSight historical data archive (*.vshda) for operation with historical data). 

Compatibility with existing VibroSight machinery monitoring projects using VibroSight OPC Servers that were 
created using VibroSight 2.12.7 or earlier is achieved using a specific VibroSight OPC Server migration process for 
these VibroSight OPC Servers. 

Therefore, it is important to note that: 

• New machinery monitoring projects created with VibroSight 7.x.x (VibroSight 3.x.x or later) will automatically 
use VibroSight historical data repositories. 

• Existing machinery monitoring projects created with versions of VibroSight earlier than VibroSight 3.0.0 must 
be manually migrated from Sybase SQL Anywhere databases to VibroSight historical data repositories before 
they can be used with VibroSight 7.x.x (VibroSight 3.x.x or later). 

• Existing machinery monitoring projects using VibroSight OPC Servers that were created with versions of 
VibroSight earlier than VibroSight 2.12.7 must manually migrate their VibroSight OPC Servers before they can 
be used with VibroSight 7.x.x (VibroSight 3.x.x or later). 
It is very important to note that migrating a VibroSight OPC Server from VibroSight 2.12.7 or earlier to 
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VibroSight 7.x.x (VibroSight 3.x.x or later) or later requires that certain steps must be performed using the 
existing version of VibroSight (that is, VibroSight 2.12.7 or earlier) BEFORE it is removed (uninstalled). 

NOTE: The manual migration of an existing machinery monitoring project to 
VibroSight 7.x.x (VibroSight 3.x.x or later) or later is described in detail in the 
“Data migration” and “VibroSight OPC Server migration” sections of the latest  

 Getting started with VibroSight installation guide. 

 
 
5.1.1 Microsoft Windows operating systems 
VibroSight 7.x.x (VibroSight 3.x.x or later) or later is compatible with 32-bit versions and 64-bit versions of 
Microsoft ® Windows ® operating systems. 

NOTE: Starting with VibroSight 3.0.0, VibroSight software is now available as 64-bit 
software for 64-bit Windows and 32-bit software for 32-bit Windows. 
The 64-bit version of VibroSight can be installed on 64-bit Windows computers 
only. The 32-bit version of VibroSight can be installed on 32-bit Windows 
computers only. Only a single version of VibroSight can be installed and exist on a 
computer at any one time 

 
See the Appendix of these release notes for further information on VibroSight software and Windows operating 
system compatibility. 

 

 

5.1.2 Microsoft .NET Framework 
For most Windows operating systems, VibroSight 7.x.x (VibroSight 3.7.0 or later) requires that the Microsoft .NET 
Framework 4.7.2 or later is installed. 

NOTE: VibroSight 7.x.x requires Microsoft .NET Framework 4.7.2. 

 
If the required Microsoft .NET Framework is not pre-installed, then the VibroSight installer will detect this and 
automatically install it as part of the VibroSight software installation process. 

See the Appendix of these release notes for further information on VibroSight software and Microsoft .NET 
Framework requirements. 
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5.1.3 Microsoft Visual C++ Redistributable Package 
VibroSight 7.x.x (VibroSight 3.x.x or later) requires that the Microsoft Visual C++ Redistributable Package for Visual 
Studio 2015 is installed, in order to install and register the Visual C++ libraries used by VibroSight. 

NOTE: The 64-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 
Visual C++ 2015 Redistributable (x64)”) must be installed on 64-bit Windows 
computers. 
The 32-bit version of the Microsoft Visual C++ Redistributable Package (“Microsoft 
Visual C++ 2015 Redistributable (x86)”) must be installed on 32-bit Windows 
computers. 

If the required Microsoft Visual C++ Redistributable Package is not pre-installed, then the VibroSight installer will 
detect this and exit the installation. 

 

 

5.1.4 OPC Core Components Redistributable 

VibroSight 7.x.x (VibroSight 3.x.x or later) requires that the OPC Core Components Redistributable is installed, in 
order to configure and run VibroSight OPC Clients and VibroSight OPC Servers correctly: the redistributable must 
be installed on OPC client computers in order to allow connections to remote OPC servers and it must be installed 
on OPC server computers in order to allow OPC clients to browse for running OPC servers. 

NOTE: The 64-bit version of the OPC Core Components Redistributable (“OPC Core 
Components Redistributable (x64) 106.0”) must be installed on 64-bit Windows 
computers. 

The 32-bit version of the OPC Core Components Redistributable (“OPC Core 
Components Redistributable (x86) 106.0”) must be installed on 32-bit Windows 
computers. 

 

If the required OPC Core Components Redistributable is not pre-installed, then the VibroSight installer will detect 
this and automatically install it as part of the VibroSight software installation. 

 

 

5.1.5 OPC UA Local Discovery Server  

VibroSight 7.x.x or later requires that the OPC UA Local Discovery Server is installed, in order to expose OPC UA 
servers for discovery and enable communications with OPC UA clients. 

If the required OPC UA Local Discovery Server is not pre-installed, then the VibroSight installer will detect this and 
automatically install it as part of the VibroSight software installation. 
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5.1.6 Sybase SQL Anywhere 11 software 

VibroSight 7.x.x (VibroSight 3.x.x or later) does not include any Sybase SQL database software. 

Starting with VibroSight 3.0.0, the VibroSight historical data repositories (VibroSight historical data folder (*.vshdf) 
for operation with a VibroSight Server (live data) and VibroSight historical data archive (*.vshda) for operation with 
historical data) are exclusively used for the required data repositories. 

A VibroSight database based on Sybase SQL Anywhere (*.vssrvdb) can no longer be used as a data repository. 
Accordingly, the Sybase SQL Anywhere 11 database software is no longer included and distributed as part of the 
VibroSight software. 

NOTE: VibroSight 3.x.x or later exclusively uses data repositories based on the VibroSight 
historical data system. 

VibroSight 2.12.7 used data repositories based on Sybase SQL Anywhere 
databases and introduced initial support for working with data repositories based 
on the VibroSight historical data repositories for data analysis. 

VibroSight 2.12.6 or earlier exclusively used data repositories based on Sybase 
SQL Anywhere databases. 

 

NOTE: The manual migration of an existing machinery monitoring project to 
VibroSight 7.x.x (VibroSight 3.x.x or later) is described in detail in the 

“Data migration” section of the latest  Getting started with VibroSight 
installation guide. 

 

 

5.1.7 Dell Backup and Recovery software 

Some Dell™ computers running versions of Dell Backup and Recovery software can experience problems running 
the VibroSight software, characterised by the VibroSight software not running or running incorrectly. This is 
because the Dell Backup and Recovery software can use a version of SQLite and associated libraries (DLLs) that 
prevent the VibroSight Host Service from running correctly. 

For example, VibroSight clients can stop running (crash), VibroSight clients can be unable to connect to data 
sources and/or VibroSight System manager may not display all of the commands expected to be available in the 
Actions window. 

If this behaviour is seen, the recommended workaround is to uninstall the Dell Backup and Recovery software. 

NOTE: It is recommended to install and use VibroSight 3.x.x or earlier on a computer that 
does not have Dell Backup and Recovery software installed. 
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5.1.8 MatrikonOPC software 

Both MatrikonOPC™ software and the VibroSight software can be installed and run on the same computer. 

However, if the MatrikonOPC software is installed after the VibroSight software, this can result in problems related 
to credentials (access rights). These problems are typically characterised by an unhandled exception in VibroSight 
Configurator when trying to configure an OPC device in the Hardware view or an unhandled exception in a 
VibroSight Server when trying to handle/process OPC data. 

MatrikonOPC software and the VibroSight software must be installed on the same computer in the following order: 

1. Install the MatrikonOPC software. 

2. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2010 (version 40219). 
Note: This redistributable package is required by the MatrikonOPC software. 

3. Install the Microsoft Visual C++ Redistributable Package for Visual Studio 2015 (version 23026 or later). 
Note: This redistributable package is required by the VibroSight software. 

4. Install VibroSight 3.x.x or later. 
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5.2 VM600Mk2/VM600 modules/cards 

5.2.1 Card firmware 

There are some firmware upgrades for VM600Mk2/VM600 modules/cards corresponding to VibroSight 7.0.0. 

 

The latest firmware for the VM600Mk2 MPC4Mk2 module is now: 

• Machinery protection: 640-025-005-000.Mpc4g2Fw 

• Condition monitoring: 640-033-001-000.VxeFw 

• Recovery: 640-031-003-006.Mpc4g2Fw 

• Proof test: 640-032-001-001.VxeFw 

See 2.3 MPC4Mk2 + IOC4Mk2 module. 

 

The latest firmware for the new VM600Mk2 CPUMMk2 module is now: 

• Base system: base-system-640-034-001-001.tgz 

See 2.4 CPUMMk2 + IOCNMk2 module. 

 

The latest firmware for the VM600 CPUR2 card is now: 

• Base System : base-system-640-014-001-005.tgz 

• Applications: applications-640-015-001-005.tgz 

See 2.5 CPUR2 + IOCR2 module. 

 

The latest firmware for the VM600 CPUR card remains: 

• Base System: base-system-640-011-001-005.tgz 

• Applications: applications-640-012-001-005.tgz 

 

NOTE: In order to help distinguish between VM600Mk2 CPUx modules and VM600 CPUx 
cards, VibroSight 6.0.0 and later uses the following terminology: 
• CPUMMk2 to refer to the VM600Mk2 CPUx module with mathematical processing of 
fieldbus data and support for Modbus TCP and PROFIBUS DP (PNR 600-050). 
• CPUR2 to refer to the latest version of the VM600 CPUx card with support for 
PROFIBUS (PNR 600-026-000-VVV). 
• CPUR to refer to the earlier version of the VM600 CPUx card with support for 
Modbus RTU/TCP and card pair redundancy (PNR 600-007-000-VVV). 
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The latest firmware for the VM600Mk2/VM600 XMC16, XMV16 and XMVS16 cards remains: 

• Base System: base-system-640-003-001-016.tgz 

• Applications: applications-640-010-001-016.tgz 

 

Therefore, for current versions of VibroSight and VM600Mk2/VM600 systems, firmware upgrades are required. 

 

 

5.3 VibroSmart devices 

5.3.1 Module firmware 

There are no firmware upgrades for VibroSmart modules and devices corresponding to VibroSight 7.0.0. 

 

The latest firmware for the VSI010 module remains: 

• 642-002-000-013.xmsifw  

 

The latest firmware for the VSN010 device remains: 

• 642-004-000-011.redboxfw  

 

The latest firmware for the VSV30x module remains: 

• 642-001-000-019.xtranfw  

 

Therefore, for current versions of VibroSmart modules and devices, no firmware upgrades are required. 
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6 Upgrade procedure 

This section describes the procedure for upgrading a VibroSight system from a previous version. Perform the steps 
in the given sequence in order to complete a system upgrade. 

NOTE: It is strongly recommended to verify the version of firmware running in the related 
hardware (XMx16 cards and VibroSmart modules and devices) before starting a 
VibroSight system upgrade, in order to establish if any firmware updates are also 
required. 
See 6.2.3 Updating the firmware using VibroSight System Manager. 

 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 
VibroSmart is available before updating the firmware of any of the VibroSmart 
modules used in the distributed monitoring system. See 6.2.3 Updating the 
firmware using VibroSight System Manager. 

 

 

6.1 VibroSight software user settings 

The VibroSight Software generates and uses some files on the storage device of the computer running VibroSight 
to keep track of user-configurable settings, so that these settings are remembered and applied for the VibroSight 
installation. 

These settings files have an .xmssettings file name extension and on a computer running Windows 7, can be found 
here: 

C:\Users\username\AppData\Roaming\Meggitt\VibroSight, where username is the Windows account name. 

For example, the VibroSightVision.xmssettings file records the user-configurable default settings for VibroSight 
Vision, such as default settings for plots. 

NOTE: VibroSight software updates and upgrades do not replace these settings files, so: 
• For a computer on which VibroSight was previously installed, an update, upgrade 
or a re-installation of VibroSight will continue to use the previous defaults recorded 
in the .xmssettings files. 
• For a computer on which VibroSight was not previously installed, the installation 
of VibroSight will generate and use new .xmssettings files, which use the latest 
VibroSight software defaults. 

If a settings file is deleted for any reason, VibroSight will generate and use a new 
settings file, which uses the latest VibroSight software defaults. 
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6.2 Updating VibroSight-compatible hardware 

Appropriate files and tools are included in the installation package to allow VM600Mk2/VM600 modules/cards 
(XMx16) and VibroSmart devices (VSI010, VSN010 and VSV30x) to be updated to the latest firmware, in order to 
take advantage of improvements to the VibroSight software. 

Updating the firmware for VM600Mk2/VM600 modules/cards cards or VibroSmart devices is a special task that can, 
if used unintentionally or incorrectly, lead to malfunctioning of the device and affect proper function of data 
acquisition. 

During the firmware update of a device, the card or module being updated cannot provide its normal machinery 
monitoring functions because its outputs (alarms and relays) can go to undetermined states, irrespective of how 
they have been configured. 

For VibroSmart modules, the machinery being monitored is not protected for the duration of a firmware update and 
the restart (reboot) that is triggered automatically after the firmware update (which can take up to 5 minutes). 

NOTE: It is highly recommended that firmware updates are only performed in accordance 
with the operating procedures for the machinery being monitored and that 
appropriate precautions are taken at the control system level (such as DCS 
or PLC). 

For example, alarms and relay outputs should be ignored (bypassed or inhibited) in 
order to avoid false trips of the machinery being monitored. 

 

6.2.1 VM600Mk2/VM600 module/card firmware 

The latest VM600Mk2/VM600 module/card firmware files are copied to a directory on your computer as part of the 
VibroSight software installation process. 

NOTE: For example, the default firmware directory for VM600Mk2/VM600 modules/cards is: 
C:\Program Files\Meggitt\VibroSight\Firmware\VM600 

 

The firmware files for a VM600Mk2/VM600 module/card can be found in the appropriate subfolder and identified by 
their .tgz file name extension. For example, the XMV16 subfolder contains the applications and base system 
firmware for use by XMV16 cards. Any additional firmware updates received from Meggitt SA should also be stored 
in these directories. 

Table 1 shows the compatibility between VibroSight software and VM600Mk2 MPC4Mk2 module hardware (that is, 
MPC4Mk2 firmware). 

Table 2 shows the compatibility between VibroSight software and VM600Mk2 CPUMMk2 module hardware (that is, 
CPUMMk2 firmware). 

Table 3 shows the compatibility between VibroSight software and VM600 CPUR2 card hardware (that is, 
CPUR2 firmware). 

Table 4 shows the compatibility between VibroSight software and VM600 CPUR card hardware (that is, 
CPUR firmware). 
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Table 5 shows the compatibility between VibroSight software and VM600 XMx16 card hardware (that is, 
XMC16, XMV16 and XMVS16 firmware). 

NOTE: It is strongly recommended to use the most recent version of the VM600 CPUR 
firmware and VM600 XMx16 firmware that is compatible with the version of 
VibroSight software being used. 
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Table 1: VibroSight software and VM600Mk2 MPC4Mk2 firmware compatibility 

 VM600Mk2 MPC4Mk2 firmware 

VibroSight software 
version 

Part number (PNR) 

Machinery protection firmware (640-025-vvv-ppp.Mpc4g2Fw) 

640-025- 

002-000 

640-025- 

003-002 

640-025- 

004-000 

640-025- 

004-003 

640-025- 

005-000 

Condition monitoring firmware (640-033-vvv-ppp.VxeFw) 

--- --- --- --- 640-033- 

001-000 

Recovery firmware (640-031-vvv-ppp.Mpc4g2Fw) 

--- 640-031- 

003-002 

640-031- 

003-004 

640-031- 

003-006 

Proof test firmware (640-032-vvv-ppp.VxeFw) 

--- 640-032- 

001-000 

640-032- 

001-001 

5.1.0 
609-004-000-049 

 See note 1  
   

6.0.0 
609-004-000-050 

  See note 2  
  

6.1.0 
609-004-000-051 

   See note 3   

7.0.0 
609-004-000-052 

    See note 4 

 

Notes for Table 1 (see the next page) 
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Notes for Table 1 
1. This version of VM600Mk2 MPC4Mk2 (previously referred to as VM600 MPC4G2) firmware is a release intended to support the ongoing 
development and evaluation of VibroSight Protect and VM600Mk2 systems only. A firmware upgrade is required in order to run VibroSight 5.1.0 
or later. 
 

2. This version of VM600Mk2 MPC4Mk2 (previously referred to as VM600 MPC4G2) firmware is the official launch release of firmware supporting 
VibroSight Protect and VM600Mk2 systems. A firmware upgrade is required in order to run VibroSight 6.0.0 or later – that is, to use VM600Mk2 
systems in “live” machinery protection system (MPS) applications. Contact Meggitt SA for further information. 
 

3. This version of VM600Mk2 MPC4Mk2 firmware improves frequency domain measurements (the phase component can be used as the input 
signal for an analog output), differential expansion (dual taper) processing (the ramp angles for the taper on the shaft are configured separately), 
auxiliary input channels configured as tacho inputs (appropriate data quality indicators and warning messages, with automatic recovery), and 
the maximum tacho speed / frequency has been increased. It also includes a number of bug fixes. (Refer to the VibroSight 6.1 release notes for 
further information.) A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 
 

4a. These versions of VM600Mk2 MPC4Mk2 firmware: 
• Improve support for machinery protection (640-025-005-000 machinery protection firmware) 
• Add support for condition monitoring (640-033-001-000 condition monitoring firmware) 
• Improve system recovery (640-031-003-006 recovery firmware) 
• Improve proof testing (640-032-001-001 proof test firmware). 
See 2.3 MPC4Mk2 + IOC4Mk2 module for further information. A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
Note: For reference, earlier versions of VibroSight / VM600Mk2 MPC4Mk2 supported machinery protection only, that is, no condition monitoring 
firmware (640-033-vvv-ppp) was available. 
 

4b. These versions of VM600Mk2 MPC4Mk2 firmware: 
• Improve support for machinery protection (640-025-004-003 and 640-025-005-000 machinery protection firmware) 
• Add support for condition monitoring (640-033-001-000 condition monitoring firmware – with 640-025-005-000 machinery protection firmware 
only) 
• Improve system recovery (640-031-003-006 recovery firmware) 
• Improve proof testing (640-032-001-001 proof test firmware). 
See 2.3 MPC4Mk2 + IOC4Mk2 module for further information. A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
Note: For reference, earlier versions of VibroSight / VM600Mk2 MPC4Mk2 supported machinery protection only, that is, no condition monitoring 
firmware (640-033-vvv-ppp) was available. 
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Table 2: VibroSight software and VM600Mk2 CPUMMk2 firmware compatibility 

 VM600Mk2 CPUMMk2 firmware  See note 1 

VibroSight software version 

Part number (PNR) 

Base-system / Applications firmware (*.tgz) 

640-034-001-000 640-034-001-001 

6.1.0 
609-004-000-051 

 See note 2  

7.0.0 
609-004-000-052 

  See note 3 

 

Notes for Table 2 
1. VM600 CPUR2 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-034-001-xxx for 
the base system firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUMMk2 module, the dialog box 
displayed by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-
034-000-xxx for the base system firmware, which correspond to the actual unpacked firmware that is running on the module. 
 

2. This version of VM600Mk2 CPUMMk2 firmware is the official launch release of firmware supporting VM600Mk2 systems. (Refer to the 
VibroSight 6.1 release notes for further information.) A firmware upgrade is required in order to run VibroSight 6.1.0 or later. 
 

3. For information on this version of VM600Mk2 CPUMMk2 firmware, see 2.4 CPUMMk2 + IOCNMk2 module.  
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
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Table 3: VibroSight software and VM600 CPUR2 firmware compatibility 

 VM600 CPUR2 firmware  See note 1 

VibroSight software version 

Part number (PNR) 

Base-system firmware (*.tgz) 

640-014-001-001 640-014-001-002 640-014-001-003 640-014-001-005 

Applications firmware (*.tgz) 

640-015-001-001 640-015-001-002 640-015-001-003 640-015-001-005 

3.4.0 
609-004-000-041 

 See note 2  See note 3   

3.5.0 
609-004-000-042 

    

3.6.0 
609-004-000-043 

    

3.7.0 
609-004-000-044 

    

3.8.0 
609-004-000-045 

    

4.0.0 
609-004-000-046 

    

4.1.0 
609-004-000-047 

   See note 4  

5.0.0 
609-004-000-048 

    

5.1.0 
609-004-000-049 

    

6.0.0 
609-004-000-050 

    

6.1.0 
609-004-000-051 

    

7.0.0 
609-004-000-052 

    See note 5 

 

 

Notes for Table 3 (see the next page)  
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Notes for Table 3 
1. VM600 CPUR2 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-014-001-xxx for 
the Base System and 640-015-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR2 card, the dialog box displayed 
by the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-014-000-xxx 
for the Base System and 640-015-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This is the first official release of VM600 CPUR2 firmware and includes features such as the management of XMx16 card configurations for 
applications such as control systems and the implementation of the PROFIBUS protocol for the fieldbus interfaces. A firmware upgrade is 
required in order to run VibroSight 2.12.7 or later. 
 

3. This version of VM600 CPUR2 firmware includes improvements such as changing the PROFIBUS polling rate for the Modbus server to 
100 ms (was 200 ms) and a bug fix for a known VM600 CPUx time counter wraparound (overflow) issue. A firmware upgrade is strongly 
recommended in order to run VibroSight 3.4.0 or later. 
 

4. This version of VM600 CPUR2 firmware includes improvements such as overall performance, responsiveness and stability, and support for 
CPUR2/IOCR2 card pair relays, and the ability to download the GSD file directly from the card. A firmware upgrade is strongly recommended 
but is not required in order to run VibroSight 4.1.0 or later. 
Note: VibroSight 4.1.0 or later must be used in order to download the VM600 CPUR2 GSD file directly from the CPUR2 card. 
 

5. For information on this version of VM600Mk2 CPUR2 firmware, see 2.5 CPUR2 + IOCR2 module.  
A firmware upgrade is required in order to run VibroSight 7.0.0 or later. 
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Table 4: VibroSight software and VM600 CPUR firmware compatibility 

 VM600 CPUR firmware  See note 1 

VibroSight software version 

Part number (PNR) 

Base-system firmware (*.tgz) 

640-011-001-004 640-011-001-005 

Applications firmware (*.tgz) 

640-012-001-004 640-012-001-005 

4.0.0 
609-004-000-046 

 See note 2  

4.1.0 
609-004-000-047 

  See note 3 

5.0.0 
609-004-000-048 

  

5.1.0 
609-004-000-049 

  

6.0.0 
609-004-000-050 

  

6.1.0 
609-004-000-051 

  

7.0.0 
609-004-000-052 

  

 

Notes for Table 4 
1. VM600 CPUR firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-011-001-xxx for 
the Base System and 640-012-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 CPUR card, the dialog box displayed by 
the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-011-000-xxx for 
the Base System and 640-012-000-xxx for the Firmware, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This is the latest official release of VM600 CPUR firmware (that is, the earlier version of the CPUx card with support for card pair redundancy 
(PNR 600-007-000-VVV)), which was discontinued in VibroSight 2.12.0 and reintroduced in VibroSight 4.0.x). 
 
3. This version of VM600 CPUR firmware includes a bug fix for a known VM600 CPUx time counter wraparound (overflow) issue and the 
addition of relay outputs to the diagnostics logs. A firmware upgrade is strongly recommended but is not required in order to run VibroSight 4.1.0 
or later. 
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Table 5: VibroSight software and VM600 XMx16 firmware compatibility 

 VM600 XMx16 firmware  See note 1 

VibroSight software version 

Part number (PNR) 

Base-system firmware (*.tgz) 

640-003-001-016 

Applications firmware (*.tgz) 

640-010-001-016 

3.4.0 
609-004-000-041 

 See note 2 

3.5.0 
609-004-000-042 

 

3.6.0 
609-004-000-043 

 

3.7.0 
609-004-000-044 

 

3.8.0 
609-004-000-045 

 

4.0.0 
609-004-000-046 

 

4.1.0 
609-004-000-047 

 

5.0.0 
609-004-000-048 

 

5.1.0 
609-004-000-049 

 

6.0.0 
609-004-000-050 

 

6.1.0 
609-004-000-051 

 

7.0.0 
609-004-000-052 

 

 

Notes for Table 5 (see the next page)  
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Notes for Table 5 
1. VM600 XMx16 firmware is packaged and distributed as a .tgz file (a compressed archive file format) with PNRs such as 640-003-001-xxx for 
the Base System and 640-010-001-xxx for the (Applications) Firmware. In these PNRs, the xxx-xxx-001-xxx denotes the firmware is packaged 
in the tgz file format. 

After the .tgz file is unpacked by VibroSight System Manager and the firmware is uploaded to a VM600 XMx16 card, the dialog box displayed by 
the VibroSight System Manager’s Change Firmware command shows the current version of firmware using PNRs such as 640-010-000-xxx for 
the Firmware and 640-003-000-xxx for the Base System, which correspond to the actual unpacked firmware that is running on the card. 
 

2. This version of VM600 XMx16 firmware includes relaxed constraints for dynamic data retention time, that is, optimised memory to reduce the 
possibility of missing data in data intensive VibroSight applications running on less powerful computers. A firmware upgrade is required in order 
to run VibroSight 3.3.0 or later. 
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6.2.2 VibroSmart device firmware 

The latest VibroSmart device firmware files are copied to a directory on your computer as part of the VibroSight 
software installation process. 

NOTE: The default firmware directory for VibroSmart devices is: 
C:\Program Files\Meggitt\VibroSight\Firmware\VibroSmart 

 

The firmware files for a VibroSmart device can be found in the appropriate subfolder and identified by their .*fw 
file name extension. For example, the VSV30x subfolder contains the firmware for use by VSV30x modules. Any 
additional firmware updates received from Meggitt SA should also be stored in these directories. 

Table 6 shows the compatibility between VibroSight software and the VibroSmart VSI010 firmware. 

Table 7 shows the compatibility between VibroSight software and the VibroSmart VSN010 firmware. 

Table 8 shows the compatibility between VibroSight software and the VibroSmart VSV30x firmware. 

 

NOTE: It is strongly recommended to use the most recent version of the VibroSmart 
firmware that is compatible with the version of VibroSight software being used. 
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Table 6: VibroSight software and VibroSmart VSI010 firmware compatibility 

 VSI010 firmware (*.xmsifw)  See note 1 

VibroSight 
software version 

Part number 
(PNR) 

642-002-000-009 642-002-000-010 642-002-000-011 642-002-000-012 642-002-000-013 

3.4.0 
609-004-000-041 

 See note 2 
See notes 

2 and 3 
 

  

3.5.0 
609-004-000-042 

   
  

3.6.0 
609-004-000-043 

   
  

3.7.0 
609-004-000-044 

   
  

3.8.0 
609-004-000-045 

   
  

4.0.0 
609-004-000-046 

   
  

4.1.0 
609-004-000-047 

   
  

5.0.0 
609-004-000-048 

  
See notes 

2 and 4 

See notes 

2 and 5 
 

5.1.0 
609-004-000-049 

     

6.0.0 
609-004-000-050 

    
 

6.1.0 
609-004-000-051 

    
See notes 

2 and 6 

7.0.0 
609-004-000-052 

     

 

Notes for Table 6 (see the next page)  
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Notes for Table 6 
1. VibroSmart VSI010 firmware is distributed as a single .xmsifw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSI010 firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time Ethernet 
switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight System 
Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after updating the 
firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSI010 modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSN010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. This version of VibroSmart VSI010 firmware has no limit on the number of constants per VSI010 module. 
A firmware upgrade is recommended but is not required in order to run VibroSight 3.8.0 or later. 
 

4. This version of VibroSmart VSI010 firmware adds support for Modbus function code 03. 
A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 
 

5. This version of VibroSmart VSI010 firmware adds support for module lock and the GOOSE communications protocol (IEC 61850). 
A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 
 

6. For information on this version of VibroSmart VSI010 firmware, refer to the VibroSight 6.1 release notes. 
A firmware upgrade is required in order to run VibroSight 6.1.0 or later.  
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Table 7: VibroSight software and VibroSmart VSN010 firmware compatibility 

 VSN010 firmware (*.redboxfw)  See note 1 

VibroSight software version 
Part number (PNR) 

642-004-000-011 

3.4.0 
609-004-000-041 

 See note 2 

3.5.0 
609-004-000-042 

 

3.6.0 
609-004-000-043 

 

3.7.0 
609-004-000-044 

 

3.8.0 
609-004-000-045 

 

4.0.0 
609-004-000-046 

 

4.1.0 
609-004-000-047 

 

5.0.0 
609-004-000-048 

 

5.1.0 
609-004-000-049 

 

6.0.0 
609-004-000-050 

 

6.1.0 
609-004-000-051 

 

7.0.0 
609-004-000-052 

 

 

Notes for Table 7 (see the next page)  
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Notes for Table 7 
1. VibroSmart VSN010 firmware is distributed as a single .redboxfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSN010 firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time Ethernet 
switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight System 
Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after updating the 
firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 

 (2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSN010 modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 

(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 

(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 

(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSV30x modules). 

(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 

(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 

During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
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Table 8: VibroSight software and VibroSmart VSV30x firmware compatibility 

 VSV30x firmware (*.xtranfw)  See note 1 

VibroSight 
software version 

Part number 
(PNR) 

642-001-000-016 642-001-000-017 642-001-000-018 

642-001-000- 

000DEV_ 

SVN14937_ 

2020-05-20 

642-001-000-019 

3.4.0 
609-004-000-041 

See notes 

2 and 4 

    

3.5.0 
609-004-000-042 

 
    

3.6.0 
609-004-000-043 

 
    

3.7.0 
609-004-000-044 

 
    

3.8.0 
609-004-000-045 

 
    

4.0.0 
609-004-000-046 

 
    

4.1.0 
609-004-000-047 

 
    

5.0.0 
609-004-000-048 

 
See notes 

2 and 5 

See notes 

2 and 6 

  

5.1.0 
609-004-000-049 

   
See notes 

2 and 7 
 

6.0.0 
609-004-000-050 

    
 

6.1.0 
609-004-000-051 

    
See notes 

2 and 8 

7.0.0 
609-004-000-052 

     

 

Notes for Table 8 (see the next page)  
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Notes for Table 8 
1. VibroSmart VSV30x firmware is distributed as a single .xtranfw file (a proprietary file format) with a PNR such as 642-xxx-000-xxx. In these 
PNRs, the xxx-xxx-000-xxx denotes that the firmware is not packaged (compressed or archived). VibroSight System Manager always uses and 
displays information about VibroSmart device firmware using PNRs such as 642-xxx-000-xxx, which correspond to the actual firmware that is 
running on the device. 
 

2. Updating to this version of VibroSmart VSV30x firmware requires a specific process: 

Notes: 

For a VibroSmart consisting of different types of device, the devices should be updated in the following order: first VSN010 real-time Ethernet 
switches, then VSV30x vibration monitoring modules and finally VSI010 communications interface modules. In addition, VibroSight System 
Manager should be exited (closed) and restarted after updating the firmware for each type of device, before continuing. And after updating the 
firmware, the configuration on the VibroSmart devices should be re-applied (re-activated) and the VibroSmart devices should be restarted. 

Procedure: 

(1) Ensure that a copy of the configuration for the VibroSmart is available before updating any device firmware. For example, using the currently 
installed version of VibroSight (that is, before any updates to the VibroSight software corresponding to updates to VibroSmart devices), 
VibroSight Configurator can be used to obtain a copy of the configuration as follows: 
• For a VibroSmart using a VibroSight Server, the File > Open > Server / Database command can be used to read the configuration from the 
VibroSight Server. 
• For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” VibroSmart), the File > Open > Device command can be used to read 
the configuration directly from the VibroSmart modules. 
Then the File > Save As > File command can be used to store a copy of the configuration for the VibroSmart. 
(2) Start VibroSight System Manager, select the device or devices of the same type to be updated (for example, VSV30x modules) and run the 
Change Firmware command. 
When updating multiple VibroSmart devices of the same type to use the same firmware, CTRL+click or SHIFT+click can be used to select 
multiple devices in the Devices tree structure of the System Explorer window. This way, when the Change Firmware command is run, all of 
devices that were selected will be updated at the same time. Otherwise, each device must be selected and updated individually. 
(3) When the VibroSmart Module(s) Firmware Upgrade window displays a “Firmware upgrade terminated. The firmware has been upgraded 
successfully …” message, click the Finish button to continue. 
If after 10 minutes, the VibroSmart Module(s) Firmware Upgrade window does not display a successful message, click the Cancel button to 
close the window and continue. 
Then exit (close) VibroSight System Manager. 
(4) Restart VibroSight System Manager and verify that the correct version of firmware is reported for each device that was updated. (When a 
device is selected in the System Explorer window, this information is available in the main window (centre) under Module PNR. It is also 
available in the VibroSmart Module(s) Firmware Upgrade window when a device is selected and the Change Firmware command is run). 
If a device does not report the correct version of firmware, rerun the Change Firmware command for this device. 
Then exit (close) VibroSight System Manager. 
(5) Repeat steps (2), (3) and (4) for each type of device to be updated (for example, VSI010 and VSN010 modules). 
(6) Start VibroSight Configurator, open the configuration for the VibroSmart (see step (1)), then apply (activate) the configuration. (If required, 
VibroSight Configurator will automatically update the configuration to the latest version and inform the user.) 
Then exit (close) VibroSight Configurator. 
(7) Turn the power supply to the VibroSmart off and wait for a few seconds. Then turn the power supply back on and verify that the system 
operates as expected. 
During this firmware update process, the behaviour of the LEDs on the front panel of the VibroSmart devices can be inconsistent and should be 
ignored. Normal LED behaviour resumes after the firmware update is complete (after step (7)). 
 

3. This version of VibroSmart VSV30x firmware adds support for hydro air-gap monitoring. 
A firmware upgrade is required in order to run VibroSight 3.4.0 or later. 
 

4. This version of VibroSmart VSV30x firmware adds support for latched alarms. 
A firmware upgrade is recommended but is not required in order to run VibroSight 3.6.0 or later. 
 

5. This version of VibroSmart VSV30x firmware adds support for configurable tacho ratios, flexible input channel to processing block mapping, 
and up to two tacho processing blocks. A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 
 

6. This version of VibroSmart VSV30x firmware adds support for module lock, PTP (precision time protocol) time synchronisation, channel 
bypass and pre-trigger data logging. A firmware upgrade is required in order to run VibroSight 5.0.0 or later. 
 

7. This version of VibroSmart VSV30x firmware improves support for hydro air-gap and magnetic-flux monitoring with a minor bug fix. 
A firmware upgrade is required in order to run VibroSight 5.1.0 or later. 
 

8. For information on this version of VibroSmart VSV30x firmware, refer to the VibroSight 6.1 release notes. 
A firmware upgrade is required in order to run VibroSight 6.1.0 or later.  
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6.2.3 Updating the firmware using VibroSight System Manager 

When performing VibroSight software upgrades, it is strongly recommended to systematically upgrade the firmware 
of VM600 XMx16 cards and VibroSmart devices to the latest compatible version. 

Failure to perform a necessary VibroSight-compatible VM600Mk2/VM600 module/card firmware update may lead to 
incoherent system behaviour and affect the proper functioning of data acquisition in a system. It is only in systems 
where the firmware running on the XMx16 cards and VibroSmart devices already corresponds to the latest 
available version that no firmware update is required. Therefore, it is strongly recommended to verify the version of 
firmware running on the hardware before starting a VibroSight system upgrade, in order to establish if a firmware 
update is also required. 

NOTE: Changing the firmware of the VibroSight hardware is a special administrative task 
that can – if performed unintentionally – affect the proper functioning of data 
acquisition in a system. 

It is therefore strongly recommended to change the firmware of the VibroSight 
hardware only when it is necessary. For example, when the devices must be 
updated to be compatible with a VibroSight software upgrade. 

 

For VibroSmart modules, each module can be selected and its firmware updated individually. Alternatively, multiple 
modules of the same type (for example, VSV3x0) can be updated to the same version of firmware at the same 
time. 

NOTE: It is strongly recommended to ensure that a copy of the configuration for a 
VibroSmart is available before updating the firmware of any of the VibroSmart 
modules used in the distributed monitoring system. 

For example, using the currently installed version of VibroSight (that is, before any 
updates to the VibroSight software corresponding to updates to VibroSmart 
modules), VibroSight Configurator should be used to obtain a copy of the 
configuration as follows:  

For a VibroSmart using a VibroSight Server, the File > Open > Server / Database 
command can be used to read the configuration from the VibroSight Server. 

For a VibroSmart not using a VibroSight Server (that is, a “stand-alone” 
VibroSmart), the File > Open > Device command can be used to read the 
configuration directly from the VibroSmart modules. 

Then the File > Save As > File command should be used to store a copy of the 
configuration for the VibroSmart distributed monitoring system. 

 

Update the firmware on a VibroSight device using the  Change Firmware tool (from VibroSight System 
Manager’s Maintenance tools): 

1. Ensure that the computer running the VibroSight software is on the same network as the hardware (XMx16 
card or VibroSmart module or device) to be updated. 
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2. Start VibroSight System Manager and navigate to the Devices tree structure in the System Explorer window. 

The Devices tree lists all of the VibroSight compatible hardware that VibroSight can see on the network. If 
there are no XMx16 cards or VibroSmart devices in the tree structure or some cards are missing, verify your 
network connections. 

3. Select the card or device that requires its firmware to be changed. 

The Actions tool window updates to show the available tools. 

To change multiple VibroSmart to use the same version of firmware at the same time, use CTRL+click or 
SHIFT+click to select multiple devices from the Devices tree-view. (Then, when the Change Firmware 
command is run, all of the devices that were selected will be updated at the same time.) 

4. Click  Change Firmware in the Maintenance tools group of the Actions window. 

The Change Firmware dialog box appears. 

5. Click the Add button and select the new firmware files for the card or new firmware file for the device. 

 NOTE: The Change Firmware dialog box automatically opens the firmware folder 
corresponding to the VibroSight-compatible VM600Mk2/VM600 module/card or 
VibroSmart device selected. 

In general, .tgz files are for VM600Mk2/VM600 modules/cards and .*fw files are for 
VibroSmart devices. 

 

6. Click the Finish button to start the firmware upgrade process. 

For XMx16 cards and VibroSmart devices, the firmware upgrade process can take up to 5 minutes, during 
which: 

• The IP address beside the device’s serial number in the Devices tree structure can disappear. 

• The LEDs on the front panel of the device can change to reflect the status of the upgrade. 

7. Repeat steps 3 to 6 for each device that requires a firmware update. 

 NOTE: Although the firmware for each VibroSight device must be changed individually 

using the  Change Firmware tool, as each device updates its firmware 
independently of the VibroSight software (once the process has started), firmware 
updates can be performed on several devices in parallel. 

 

8. After the firmware upgrade, verify that the VibroSight system is acquiring data from the cards. 

 NOTE: Refer also to the Changing the firmware topics in the  VibroSight help. 
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The  Change Firmware tool can be used to load a VibroSight device with any version of firmware. It is 
therefore possible to change a device’s firmware to any previously available version, as well as the latest update. 

This feature can be useful in certain situations, for example, swapping spare VibroSight hardware between different 
VM600 racks or VibroSmart distributed monitoring systems, where systems are operating with different versions of 
VibroSight. 

 

6.3 Final checks 

After upgrading the VibroSight software, it is recommended to check that VibroSight has not been inadvertently 
modified and that it continues to operate normally. 

 

In particular, it is recommended to check any VibroSight Servers in order to ensure that the data acquisition and 
external interfaces, data post-processing and/or logging are all configured as expected. 

 

In a VibroSight Server user interface: 

• On the Status tab under Device drivers, check that the VM600, VibroSmart, OPC and Modbus controls are 
enabled or disabled as required by your application. 

• On the Status tab under Server features, check that the Basic math, Air gap, Combustion monitoring, Duration 
counters, VSHDA import and Data logging manager controls are enabled or disabled as required by your 
application. 

• On the Log messages tab, check the listed messages (Info level) to ensure that the hardware 
(VM600Mk2/VM600 modules/cards and /or VibroSmart modules) have been discovered and that data acquisition 
has resumed. 

NOTE: When a VibroSight Server is running as a Windows service, the usual VibroSight 
Server user interface is not displayed, so VibroSight System Manager must be 
used to work with the VibroSight Server. 

That is, VibroSight System Manager can be used to connect to a VibroSight Server 
in order to check and configure the operation of the server’s drivers and features. 

 

 

Finally, after an upgrade, it is strongly recommended to use VibroSight Vision to connect to any VibroSight Servers 
in order to verify that new live and/or historical data is available. 
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7 Customer support 

7.1 Contacting us 

Meggitt SA worldwide customer support network offers a range of support including Technical support and Sales 
and repairs support. For customer support, please contact your local Meggitt representative. Alternatively, contact 
our main office: 

Customer support  
Meggitt SA 

Route de Moncor 4 
Case postale 
1701 Fribourg 
Switzerland 

 

Telephone: +41 (0) 26 407 11 11 
Email: energysupport@ch.meggitt.com 

Website: www.meggittsensing.com/energy 

 

7.2 Technical support 

Meggitt SA technical support team provide both pre-sales and post-sales technical support, including: 

• General advice 

• Technical advice 

• Troubleshooting 

• Site visits. 

 

7.3 Sales and repairs support 

Meggitt SA sales team provide both pre-sales and post-sales support, including advice on: 

• New products 

• Spare parts 

• Repairs. 

 

 

mailto:energysupport@ch.meggitt.com
http://www.meggittsensing.com/energy
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VibroSight software and Windows® operating system compatibility 

 

 
Windows 11 Windows 10 Windows 8.1 

VibroSight software compatible? Yes Yes 

Yes 
but not recommended for new 

installations as Microsoft mainstream 
support ended in 2018 

(extended support will end in 2023) 

 

 

VibroSight software and Windows® Server operating system compatibility 

 

 
Windows Server 2022 Windows Server 2016 Windows Server 2012 

VibroSight software compatible? Yes Yes 

Yes 
but not recommended for new 

installations as Microsoft mainstream 
support ended in 2018 

(extended support will end in 2023) 
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VibroSight software and Microsoft® .NET Framework requirements 

VibroSight software version Microsoft .NET Framework requirements 

VibroSight 3.7.0 or later .NET Framework 4.7.2 See note 1 

VibroSight 3.4.0 or later .NET Framework 4.7.1 See note 2 

VibroSight 3.0.0 or later .NET Framework 4.6 

VibroSight 2.12.0 or later .NET Framework 4.5 and .NET Framework 2.0 See note 3 

VibroSight 2.9.4 or later .NET Framework 4.5 

VibroSight 2.9.3 and 2.9.2 .NET Framework 4 (Standalone Installer) 

VibroSight 2.9.1 or earlier .NET Framework 3.5 SP1 
 

Notes 

1. Microsoft .NET Framework 4.7.2 replaces .NET Framework versions 4.0 to 4.7.1. 

2. Microsoft .NET Framework 4.7.1 replaces .NET Framework versions 4.0 to 4.7. 

3. Since Microsoft .NET Framework 3.5 also includes .NET Framework 2.0 and .NET Framework 3.0, installing Microsoft .NET Framework 3.5 SP1 is the recommended solution for most computers (rather than 

installing Microsoft .NET Framework 2.0). 
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